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Changes from previous releases 

Since 2408-014-HB-D 

Section on Deconstructing rho added.  

Hyperlinks activated. 

Since 2408-014-HB-C 

Spectral data 

JPII values are now scaled to the ALED output using the Fv PEP values instead of the PII PEP values. 

This change has been implemented because the PII PEP values from heterogeneous samples can 

incorporate quantitative errors that are absent from the Fv PEP values. The PII PEP values are still 
reported because, when viewed in combination with the Fv PEP values, they provide potentially 
valuable qualitative information. 

AutoSTAF and the Digital Control Unit (DCU) 

Functions have been added to RunSTAF to accommodate the deployable AutoSTAF system in 
combination with the DCU. 

Since 2408-014-HB-A 

Spectral data 

Spectral data (1 nm resolution) from all MLED channels and the actinic LED are used to apply a 
Spectral Profile Correction (SPC) to the PEP data. This allows for: 

• Normalization of the Fv and PII values at each MLED waveband to the ALED spectral output  

• JVPII and GOPII values scaled to the ALED output using the Fv PEP values 

• JPII values scaled to the ALED output using the PII PEP values 

See: Photochemical Excitation Profile (PEP) 

Application of SPC requires the presence of an scs file at the following location… 

CT_RunSTAF → Calibration files 

The required scs files have already been generated for each LabSTAF system in circulation. They can 
be accessed through the RunSTAF update link shown below. 
See: LabSTAF calibration for installation details.  

Relaxation phase 

Relaxation phase parameters are now derived from the Rho fit, rather than the Fv fit, to provide a 
closer match to the reopening of closed RCII. 

An overall relaxation phase  value is generated as an rPE parameter 
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Package effect correction 

The Package Effect Correction (PEC) can now be applied using the value generated from the Dual 
Waveband Measurement (DWM) or a user-set value. 

Interface 

The Clear file details button on the home screen has been replaced with a menu option (File → 
Clear file details) 

Pre-FLC options 

In FLC mode, the pre-FLC illumination function has been modified to run before the Auto LED, Auto 
DWM and Auto PEP functions. The function incorporates light and dark stages, either of which can 
be set to zero time. 

Updates to this document 

This document has been uploaded to oceanbestpractices.org. This site provides access to the most 
recent release of uploaded documents. 

The current DOI is… 

http://dx.doi.org/10.25607/OBP-1029.2 

This document is also included within the RunSTAF download link… 

https://1drv.ms/u/s!AkUtV8PHZSmVsMEO8Sk09MUnV1O4vg?e=mHd2iz 

1 Introduction 

This introductory section provides a brief overview of the development of LabSTAF and RunSTAF and 
future aims for the development of Single Turnover Active Fluorometry (STAF). It also includes a 
description of the major differences between LabSTAF and the previous generation of active 
fluorometers.  

1.1 The STAFES-APP project 

LabSTAF is the first of a new generation of research-grade active fluorometers being developed by 
Chelsea Technologies Ltd (CTL) in collaboration with The University of Southampton (UoS), the 
National Oceanographic Centre (NOC) and The University of Essex (UoE) as part of the STAFES-APP 
project within the NERC-funded OCEANIDS programme (NE/P020844/1). 

The STAFES-APP acronym expands to Single Turnover Active Fluorometry of Enclosed Samples – for 
Autonomous Phytoplankton Productivity. The aim of the project is to develop highly sensitive 
benchtop and deployable systems that can be used to improve our understanding of the global 
carbon cycle and aquatic ecosystem function.  

Meaningful assessment of the global carbon cycle must incorporate Phytoplankton Primary 
Productivity (PhytoPP) which forms the base of the marine food chain and represents approximately 
half of the carbon fixed by photosynthesis on a planetary scale. It follows that measurement of 
PhytoPP on wide spatial and temporal scales has enormous potential for developing our 
understanding of ocean productivity and verifying climate change models. Arguably the most 
important way in which this target can be achieved is through the validation and development of 
satellite remote sensing, which operates on the widest possible spatial scales, but which currently 
has large errors for the estimation of PhytoPP. Most of the current methods used to measure 
PhytoPP directly are laboratory-based. As a consequence, these methods can only be applied on 

http://dx.doi.org/10.25607/OBP-1029.2
https://1drv.ms/u/s!AkUtV8PHZSmVsMEO8Sk09MUnV1O4vg?e=mHd2iz
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scales that fall well short of those required. The end result is extreme undersampling of the oceanic 
environment for PhytoPP (e.g., Lee et al. 2015). 

Global assessment of PhytoPP falls within the remit of the Global Ocean Observing System (GOOS) 
which defines and prioritises a range of Essential Ocean Variables (EOVs). The fundamental criteria 
employed for defining EOVs are impact and feasibility: to make it on to the GOOS list, an EOV must 
have high impact and be measurable on meaningful scales using cost effective technology. Although 
PhytoPP clearly satisfies the impact criterion, the limitations of existing methods means it currently 
scores very low on the feasibility scale. PhytoPP responds to multiple, highly dynamic environmental 
drivers including light, temperature and nutrients. It follows that PhytoPP needs to be assessed at 
spatial and temporal scales that are at least as high as for existing EOVs and that new technologies 
and methodologies are required achieve this. 

Clearly, PhytoPP cannot be considered as a potential EOV while measurement scales are largely tied 
to land-based laboratories and the availability of research ships. In this context, autonomous 
platforms such as buoys, moorings, autonomous surface vehicles, gliders and Argo floats, provide 
opportunities to greatly increase both spatial and temporal scales for PhytoPP assessment. The 
challenge is to develop systems that can be deployed on these platforms and generate meaningful 
parameters with acceptably low errors. This challenge is central to the STAFES-APP project and 
LabSTAF is the first product. It is a highly portable benchtop system incorporating a range of options 
for both manual and highly automated operation.  

Although LabSTAF is limited to deployment on buoys, moorings and surface vessels, a 600 m 
deployable version (AutoSTAF) will be available by Late 2021. A Digital Control Unit (DCU) will be 
released at the same time as AutoSTAF. The deployable DCU will provide control of a Sea-Bird pump 
for sample exchange, provide COM-based inputs for one or two Spectral Photosynthetically Active 
Radiation (SPAR) sensors and either fully autonomous system control using an embedded Windows 
PC or remote control through an RS232 or RS422 interface. The DCU will also power the AutoSTAF 
unit. The DCU power input will be 9 to 36 V DC. 

1.1.1 Using STAF to monitor PhytoPP 

Although STAF measurements have revolutionised our understanding of phytoplankton 
ecophysiology in oceanic systems over more than twenty years (Kolber, Prášil and Falkowski, 1998), 
it is only with more recent technological and theoretical developments that STAF has become a 
potentially enabling technology for the assessment of PhytoPP at the resolution and accuracy 
required for consideration as an EOV (Oxborough et al. 2012; Boatman, Geider and Oxborough, 
2019).  

Rates of PhytoPP are constrained by the availability of chemical energy for carbon fixation which is 
almost entirely derived from the light reactions of oxygenic photosynthesis. LabSTAF provides values 
for the three key parameters required for quantitative assessment of oxygenic photosynthesis: the 
availability of photons, through use of a calibrated actinic source; the absorption of photons, using a 
STAF-derived absorption coefficient; and the proportion of absorbed photons used to drive oxygenic 
photosynthesis, using a STAF-derived efficiency parameter.  

The absorption of photons by the light harvesting systems within phytoplankton is spectrally 
dependent, with highly variable spectral characteristics among groups (Suggett et al. 2004). To 
minimize spectral errors, the actinic light source used within both LabSTAF and AutoSTAF is 
spectrally characterised and both systems incorporate seven excitation wavebands to allow spectral 
assessment of photochemical activity. The deployable AutoSTAF also includes an option to 
incorporate one or two spectrometer-based Spectral PAR (SPAR) sensors to measure spectrally 
resolved photon irradiance at the point of sampling. 
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The actinic light source integrated within LabSTAF and AutoSTAF allows for assessment of the 
photon irradiance dependence of PhytoPP through the application of Fluorescence Light Curves 
(FLCs). FLCs comprise an automated set of STAF measurements made at several photon irradiance 
levels between darkness and saturating light, providing information equivalent to the traditional 
carbon fixation or oxygen evolution based ‘PE’ curves. Depending on time of day and environmental 
conditions, a LabSTAF integrated within an underway system on board a research vessel can 
generate between two and six complete PE curves per hour. It is anticipated that AutoSTAF will 
achieve a similar output. 

1.1.2 Potential EOVs from STAF systems 

Historically, the most widely employed methods for monitoring PhytoPP have involved 
measurement of 14C-assimilation into particulate matter or related methods that measure CO2 or O2 
dynamics (Geider and Osborne, 1992; Sakshaug et al. 1997). These methods are not suitable for 
deployment on autonomous vehicles and, in addition, require long incubation times. In sharp 
contrast, deployed STAF systems have the potential to generate data on spatial scales from a few 
metres up to oceanic basin scales and temporal scales of seconds to tens of minutes, depending on 
the level of detail required. It follows that STAF has clear potential for the provision of meaningful 
EOVs for use in the assessment of PhytoPP, particularly when combined with nutrient and other EOV 
data. 

The combination of LabSTAF hardware and RunSTAF software allows for measurement of 
photosystem II (PSII) photochemical flux per PSII (JPII) and PSII photochemical flux per unit volume of 
ocean or other medium (JVPII) using the so-called sigma and absorption methods respectively. The 
accuracy of both parameters is highly dependent on accurate calibration of the instrument, spectral 
correction and, in the case of JVPII, correction for the so-called package effect. A great deal of work 
has already gone into minimising the errors associated with these processes and this work will 
continue through the remainder of the STAFES-APP project and beyond. The output from this work 
will be made available through updates to the RunSTAF software and this document plus 
submissions for peer-reviewed publication. 

1.1.2.1 Gross Oxygen release by PSII 

On the assumption that every photon used to drive PSII photochemistry results in the transfer of an 
electron from the PSII Oxygen Evolving Complex (OEC) to the plastoquinone pool, JVPII is 
proportional to Gross Oxygen release by PSII per unit volume of ocean or other medium (GOPII). 
Because the release of each O2 by the OEC requires the transfer of four electrons to plastoquinone, 
GOPII is calculated as JVPII divided by four. At this time, there is not enough supporting data to justify 
using JVPII as a proxy for GOPII at the EOV level. However, the data available from past studies clearly 
illustrate the potential for LabSTAF and AutoSTAF to provide this parameter (Oxborough et al. 2012; 
Silsbe et al. 2015; Boatman, Geider and Oxborough, 2019). 

1.1.2.2 Dark STAF parameters 

The absorption coefficient for PSII light harvesting (aLHII) is integral to the absorption method. It is 
generated from a STAF measurement made on a dark-adapted sample and quantifies the proportion 
of incident photons that are absorbed and made available for PSII photochemistry. In addition to 
aLHII, dark STAF measurements can generate a value for the absorption cross section of PSII 

photochemistry (PII), estimate PSII photochemical efficiency (PII) and provide a time constant for 

the transfer of electrons from closed PSIIs to the plastoquinone pool (). The lack of requirement for 
an actinic light source means that these parameters can be generated by a STAF unit that is 
significantly smaller, simpler and with a lower power requirement than LabSTAF or AutoSTAF, 
thereby opening up the range of platforms on which STAF units can be integrated. Between now and 
2024, CTL will be developing and testing STAF units of this type within the European Commission-
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funded HORIZON 2020 Technologies for Ocean Sensing (TechOceanS) project (Technologies for 
Ocean Sensing | TechOceanS Project | H2020 | CORDIS | European Commission (europa.eu)). 

Of the dark STAF parameters, aLHII arguably has the highest potential for improving the estimation of 
PhytoPP from satellite data, making it the best candidate for consideration as an EOV. However, it is 

worth noting that PII and PII are generated by exactly the same measurement as aLHII and that 

inclusion of  requires minimal additional effort. Consequently, the potential exists for the inclusion 
of all four parameters as EOVs. 

Changes from FastOcean and Act2 

LabSTAF represents a significant update to the well-established combination of FastOcean Fast 
Repetition Rate fluorometer (FRRf) and Act2 laboratory system. The list of advantages that LabSTAF 
has over FastOcean plus Act2 includes: 

• More than ten times the sensitivity 

• Much lower optical filter breakthrough 

• Two fluorescence detection wavebands instead of one 

• Seven fluorescence excitation LED wavebands instead of three 

• DC actinic light source providing 10 to 2000 µmol photons m-2 s-1  

• A circulating water jacket that avoids intersection with all optical paths 

• Increased FLC automation 

• Extended data analysis 

• Improved access to primary data 

The increased sensitivity arises through a switch from the 1 µs FRRf 'flashlets' on a 2 µs pitch to a 
solid excitation pulse from the excitation LEDs plus improvements to the optical arrangement. An 
added advantage of the switch from FRRf to a solid pulse is that the same number of data points can 
be collected in half the time. Consequently, the default Single Turnover (ST) pulse has been 
shortened from 200 µs (FastOcean) to 100 µs (LabSTAF). 

The much lower filter breakthrough is the result of the change in optical configuration and the use of 
better optical filters. The most obvious benefit is reduced blank values when sampling within 
extreme oligotrophic regions. 

The incorporation of two fluorescence detection wavebands within LabSTAF, centred at 685 nm and 
730 nm, allows for correction of the package effect (Boatman, Geider and Oxborough, 2019). 
See: Package Effect Correction (PEC) 

The seven measurement wavebands allow for routine spectral analysis based on variable 

fluorescence (Fv) and the absorption cross section of PSII photochemistry (PII). This analysis 

includes automated spectral correction of primary data by generating Fv and PII values for the 
actinic light source. 
See: Photochemical Excitation Profile (PEP) 

The blue-enhanced DC actinic source incorporated within LabSTAF improves signal to noise and 
avoids the potential for measurement artefacts associated with Pulse Width Modulation (PWM). 
See: The actinic light source 

Avoiding intersection between the water jacket and all optical paths allows underway water (for 
example) to be used to maintain the temperature of the sample. The LabSTAF optics and electronics 
are sealed to prevent condensation in situations where there is a need to maintain the sample 
temperature at well below ambient. The relative humidity within the LabSTAF unit is reported by 

https://cordis.europa.eu/project/id/101000858
https://cordis.europa.eu/project/id/101000858
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RunSTAF each time it is attached. 
See: Sample temperature control 

The improved FLC automation allows for the inclusion of a pre-illumination and a dark step after 
sample exchange between successive FLCs.  
 

The extended data analysis includes a new ST curve fitting function that assumes connectivity among 
PSII complexes is entirely attributable to dimerization. 
See: Data processing within RunSTAF 

Although RunSTAF incorporates a range of functions for real time data analysis, straightforward 
transfer of primary data and derived parameters is also possible, through the Windows Clipboard 
and bulk generation of csv files. Access to primary data is provided to allow for analysis with user-
formulated and/or third-party algorithms and integration within databases. 
See: Data export functions 
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2 STAF terminology 

This section provides an overview of the terminology used within this document and introduces 
some unique features of LabSTAF and RunSTAF. 

2.1 The RunSTAF screens  

The home screen is shown when RunSTAF is started and provides access to Gaq-level data when 
running in auto FLC mode. 

The data screen provides access to the Saq-level ST curves and data plots for both auto FLC and 
manual modes. 

The calibration screen shows the calibration data from an attached LabSTAF or open data file. 

2.2 Accommodating new features 

Introduction of the dual ST pulse method, the dimer fitting procedure and other new features have 
necessitated the introduction of new terminology. For the sake of consistency, a structured 
approach has been taken to generate these terms. Although this approach has led to the use of 
alternatives to some established terms, most are identical or very close to terms that have been in 
use for several decades. 
See: Glossary of terms 

2.3 SI units and reported units 

SI units and units officially accepted for use with the SI system are used throughout this document. 
When discussing the derivation of quantities, base SI units are used. Reported units include 
commonly used standard SI prefixes, where appropriate. For example, photon irradiance within an 
equation will have units of photons m-2 s-1 or mol photons m-2 s-1 (depending on context) while 
actinic photon irradiance is reported with units of µmol photons m-2 s-1.  

2.4 Irradiance and photon irradiance 

Irradiance is the radiant flux (power) received by a surface per unit area. The SI unit of irradiance is 
W m-2. As is generally the case for biological processes, photon flux is more useful than radiant flux 
when quantifying photosynthesis. Throughout this document, photon irradiance is used in 
preference to irradiance. The reported units are µmol photons m-2 s-1. Photon irradiance is denoted 
by the symbol E. 

2.5 Photosystem II Reaction Centre (RCII) 

RCII is taken to include all subunits required for stable charge separation between P680 (the PSII 
primary electron donor) and QA (the first stable electron acceptor). An RCII can be in the open state 
(capable of using available photons to drive PSII photochemistry) or the closed state (where charge 
separation at PSII is inhibited by reduction of QA).  

2.6 Photosystem II Light Harvesting System (LHCII) 

The term LHCII is applied to any structure containing light harvesting molecules that can transfer 
photons to the RCII. 

2.7 Photosystem II (PSII) complex 

A PSII complex comprises a RCII plus a LHCII. When a PSII complex is described as being open or 
closed, it is referencing the status of the RCII within the complex. A PSII complex can be 
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photochemically active (open or closed state) or photoinactivated (requiring repair before photons 
can be used to drive PSII photochemistry). 

2.8 PSII photochemical flux per photosystem (JPII) 

This term is used to quantify the flux through the absorption cross section for PSII photochemistry 
provided by a single PSII complex (units of photons PSII-1 s-1). The sigma method is used to generate 
values of JPII. 

2.9 PSII photochemical flux per unit volume (JVPII) 

This term is used to quantify the flux through the absorption cross section for PSII photochemistry 
provided by all PSII complexes within a unit volume of ocean or other medium (SI units of photons 
m-3 s-1 or mol photons m-3 s-1, reported units of µmol photons m-3 s-1). The absorption method is used 
to generate values of JVPII. 
See: Generating values of JPII, JVPII and GOPII 

2.10 Photosynthetic Gross Oxygen release by Photosystem II (GOPII) 

This is the moles of oxygen molecules released by PSII photochemistry per unit volume per unit time 
(SI units of mol O2 m-3 s-1, reported units of mmol O2 m-3 h-1). Values reported by RunSTAF assume 
that each O2 released requires four stabilised charge separation events at PSII. 
See: Generating values of JPII, JVPII and GOPII 

2.11 Electron Transport Rate (ETR) 

Although not actually reported by RunSTAF, ETR can be derived from JPII (converting photons PSII-1 s-

1 to electrons PSII-1 s-1) or JVPII (converting photons m-3 s-1 to electrons m-3 s-1). On the assumption 
that each photon used to drive PSII photochemistry, the numeric value or ETR is the same as the 
value of JPII or JVPII from which it is derived. While is it generally accepted that the ultimate source of 
the electrons being transported is oxygen, the value of ETR is actually the rate at which electrons 
reach their defined destination. Clearly, the further along the electron transport chain this 
destination is, the more scope there is for a mismatch between JPII or JVPII and ETR. 

2.12 Phytoplankton Primary Productivity (PhytoPP) 

This term is used as a catch-all for photosynthetic carbon assimilation. No distinction is made 
between gross and net primary productivity and values for PhytoPP are not reported by RunSTAF. 

2.13 Units of fluorescence (F) 

Although the reported fluorescence values are unitless, the LabSTAF calibration procedure places 
the fluorescence output on a defined STAF Unit (SU) scale. Importantly, this allows for derivation of 
the absorption coefficient for PSII light harvesting (aLHII) which is used in the calculation of JVPII and 
GOPII. 
See: LabSTAF calibration 

2.14 Single Turnover (ST) 

This term implies that each PSII reaction centre undergoes one charge separation event during each 
Single Turnover (ST) pulse. A more reasonable assumption is that approximately 12% of centres 
undergo a second charge separation event when the default 100 µs ST pulse is used. This figure 
more than doubles with a 200 µs ST pulse, to approximately 27%.  
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2.15 Data averaging terminology 

At very low biomass, averaging of ST data is required to generate reliable curve fits. The base level of 
ST data is termed the Seq (sequence). Several Seqs can be averaged to generate the next level of ST 
data, the Acq (acquisition) and several Acqs averaged to generate the next level of ST data, the Saq 
(super acquisition). These relationships are illustrated by the example in Figure 2.1. 

 

Figure 2.1: Sample ST data acquired at 4 
Seqs per Acq and 2 Acqs per Saq. 

Seqs are not stored within a RunSTAF data file. Acqs are stored, but not processed in real time. Saqs 
are processed in real time and displayed. This data structure provides a high degree of control over 
data acquisition. For example, one Seq per Acq and eight Acqs per Saq could be set for a low 
biomass sample to provide the highest level of temporal resolution (since every Acq stored will 
represent a single Seq) while generating a high enough S:N to allow real time fitting of the Saq level 
data. At the other end of the scale, setting eight Seqs per Acq and one Acq per Saq minimises the 
size of the data file at a set temporal resolution. 

When the dual ST pulse method is used, the programmed level of data averaging is applied to each 
gap length within the Set. The product of Seqs per Acq, Acqs per Saq and gaps per Set is defined as a 
Group. When running in the Auto FLC mode, all first ST pulses from the Saqs within a Group are 
averaged to generate a Group acquisition (Gaq). Within the example provided above, the six gaps 
and eight Seq per Acq make each Gaq an average of 48 Seqs. 

Gaq ST curves are not displayed by RunSTAF but are accessible through data export functions. 
See: The rPE data fit and Data export functions 

2.16 Dual ST pulse-based relaxation phase 

The established FRRf method (Kolber, Prášil and Falkowski, 1998) uses a series of very short, very 
intense 'flashlets' to form a ST pulse. Typically, each flashlet is 1 µs and the interval between 
successive flashlets is also 1 µs. As an example, the default FastOcean ST pulse comprises 100 
flashlets over 200 µs. At the end of this ST pulse, most PSII reaction centres (RCIIs) are in the closed 
state. 

With the FRRf method, the reopening of closed RCIIs can be tracked by applying a relaxation phase 
measurement that typically comprises tens of widely spaced flashlets. Analysis of the relaxation 
phase is complicated because a proportion of the reopened RCIIs are reclosed by each relaxation 
phase flashlet. 

LabSTAF uses a dual ST pulse-based relaxation phase method. This incorporates a repeating 'Set' 
comprising multiple pairs of ST pulses (Figure 2.2). The paired pulses are normally the same 
duration, with a variable gap between them. The default Set incorporates six gaps of 200, 400, 800, 
1600, 3200 and 6400 µs between the end of the first ST pulse and the start of the second ST pulse. 
The interval between the end of the second ST pulse in one pair and the start of the first ST pulse in 
the next pair is constant, with a default value of 120 ms. Although this approach usually generates 
fewer relaxation phase points than a typical FRRf relaxation phase measurement, these points have 
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much higher precision and require fewer assumptions to be made when deriving relaxation phase 
parameters. 

The default Seq interval set by RunSTAF is 120 ms. Although RCIIs closed by a single ST pulse 
normally reopen on a much shorter timescale than this, a long sequence of ST pulses applied to a 
static dark sample can result in the accumulation of closed RCIIs. This occurs over several seconds to 
tens of seconds and is due to the reduction of electron carriers downstream of PSII. This 
downstream reduction of electron carriers feeds back to PSII and increases the time required for 
RCIIs that have been closed by an ST pulse to reopen. 

 

Figure 2.2: The gap 
between the two ST 
pulse in this 
example cropped 
from the data 
screen is 800 µs. 

 

See: The relaxation phase (tau) fit 

2.17 Interrogated volume 

The LabSTAF sample chamber can hold up to 20 mL of sample. ST data are acquired from a sub-
volume of approximately 0.5 mL (the interrogated volume). The measurement LEDs (MLEDs) are 
focussed on a slightly larger volume to ensure that the interrogated volume  is evenly illuminated by 
the MLEDs. The entire sample is evenly illuminated by the actinic light source.  

Exchange of cells between the interrogated volume and the rest of the sample within the LabSTAF 
sample chamber greatly decreases the accumulation of closed RCIIs. If the supplied stirrer unit is 
used, the cells within the interrogated volume are actually exchanged several times during a Group 
acquisition of a few seconds which further decreases the accumulation of closed RCIIs. 
See: LabSTAF hardware setup 

2.18 Correcting for the package effect 

The absorption method for assessing JVPII and GOPII is sensitive to the so-called package effect 
(Boatman, Geider and Oxborough, 2019). Within RunSTAF, a Package Effect Correction (PEC) is 
applied to correct for this phenomenon. A value for the PEC parameter can be set manually by the 
user or generated by the Automated Dual Waveband Measurement (Auto DWM) function.  
See: Package Effect Correction (PEC) 

2.19 Spectral correction 

The Measurement LEDs (MLEDs) within LabSTAF emit within narrow spectral bands while the Actinic 
LED (ALED) within LabSTAF provides a broad spectral output. It follows that derivation of JPII, JVPII 
and GOPII values must include a spectral correction to account for the difference between the overall 
output from the combination of MLEDs used to generate the primary ST data and the output of the 
ALED. 

The spectral correction protocol incorporated within RunSTAF generates values of Fv and PII for 
each of the MLED wavebands through the Photochemical Excitation Profile (PEP) function. The PEP 
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data are then used to generate values of Fv and PII that are spectrally matched to the ALED. Only 
the Fv PEP data are used to apply a spectral correction to JPII, JVPII and GOPII values. 
See: Photochemical Excitation Profile (PEP) 

In Figures 2.3 and 2.4, the Fv and PII values shown next to the key lines are for the selected MLED 
waveband (447 nm). The numbers in brackets are ratios of the selected MLED parameter values to 
the ALED values. In this case, the photon yield of Fv for the 447 nm waveband is 1.618 x greater than 

it would be for the ALED and the PII value for the 447 nm waveband is 1.77 x greater than it would 
be for the ALED. 

 

Figure 2.3: This PEP example, cropped 
from the home screen, plots the Fv and 

PII values for each MLED waveband. 
The sample was cultured cells of the 
diatom, Conticribra weissflogii (CCAP 
1085/18). The differences observed 

between Fv and PII values were 
consistent over a series of reps. 

 

 

Figure 2.4: The Spectral Correction 
Spectra (SCS) from the MLEDs and ALED 
are recorded at 1 nm resolution as part 
of the LabSTAF calibration procedure. 
These data are used by RunSTAF within 
the spectral correction protocol. 
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3 RunSTAF menus 

3.1 File 

 

In addition to the standard file menu options, the File 
menu includes functions to update the Ka value 
applied across all files within a folder and refit all 
RunSTAF files within a folder. 

Only one file at a time can have access to an attached 
LabSTAF. Consequently, the New command is only 
active when the current file contains data (and is, by 
definition, no longer new) and acquisition has been 
stopped to release the LabSTAF unit.   

 

The csv files option opens a sub-menu of functions for 
generating character separated value (csv) files. The 
Folder-based file and Individual files options are only 
available when RunSTAF is first started.  

If the Auto archive report line option is checked, a csv 
summary file is created to match with each data file 
generated by RunSTAF. 
See: Data export functions 

 

The Field separator for csv output option opens a sub-menu that allows the 
default Comma field separator to be replaced with a Tab or a Semicolon. The 
selection is applied across all csv files generated by RunSTAF. 

3.2 Settings 

 

Look for STAF system must be active for data acquisition. 

When Run acquisition on start-up is active, acquisition 
starts as soon as the connected LabSTAF is attached to 
RunSTAF. 

If Prime the sample chamber on run is active, RunSTAF 
will implement the Exchange settings from FLC Setup 
before starting acquisition. 

 

The Acquisition mode sub-menu includes the standard Auto FLC 
and Manual modes. The Auto FLC through DCU mode is specifically 
for autonomous deployment of AutoSTAF plus Digital Control Unit. 
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The STAF setup and FLC setup menus both provide options to save and load 
settings to a named file and to reset to the default values. 

 

The Font and Symbol sizes sub-menu provides options that can be used to 
improve the screen layout. These are primarily for use on computers other 
than the supplied Surface Go 2.  

RunSTAF must be restarted to implement a change in font size. Symbol 
size changes are implemented immediately. 

 

The Factory sub-menu provides access to functions for factory 
use.  
See: LabSTAF calibration 

3.3 Clipboard 

 

The Clipboard menu incorporates options for copying data from an 
open file to the Windows Clipboard.  

Options not available from a specific file are greyed out. In the 
example shown here, the file includes valid DWM data, PEP data, 
rPE data and Tau data. The Acq options are greyed out because the 
number of Acqs per Saq was set to one. Consequently, these 
functions would generate the same output as the equivalent Saq 
functions. 

 

3.4 Help 

The Help menu has only one member… 

 

This provides the current version of RunSTAF through About RunSTAF... 
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4 An introduction to the Auto FLC mode 

4.1 Overview 

The Auto FLC mode within RunSTAF incorporates a wide range of features for protocol design. The 
LabSTAF system includes a range of accessories which can be combined with these features to 
provide different levels of automation. Figure 4.1 shows the physical setup used for this introduction 
to the FLC mode. It incorporates the peristaltic pump unit, solenoid unit and flow-through stirrer 
unit included within the supplied accessory kit. 

For sample exchange, solenoid valve A is switched from the default position of Normally Open (NO) 
to Normally Closed (NC) state. This allows the peristaltic pump to pull a fresh sample into the sample 
chamber (in this case, from the sample bottle located within the water bath). This displaces the 
previous sample which passes through the peristaltic pump head (in this case, into a waste bottle 
located behind the unit). 

Once sample exchange has completed, solenoid valve A is switched back to the NO state and all 
tubing between the solenoid valve and the waste bottle are flushed with air. The peristaltic pump is 
then turned off. While the FLC is running, the Mix function is used to refresh the air space above the 
sample between Steps. 

Figure 4.1: The system used to generate the examples within this section. The sample exchange process 
displaces the cells within the sample chamber with cells from the bottle sat in the water bath. The displaced 
cells are transferred to a waste bottle located out of view. 
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4.2 Auto FLC mode 

The screenshot below provides an example of the RunSTAF home screen when the Auto FLC 
acquisition mode is selected and before a RunSTAF unit has been attached. The values shown in teal 
are editable. The orange values are set by RunSTAF. Yellow text fields are buttons. An editable field 
can be selected by touching the screen or use of the keyboard touchpad. Buttons can be pressed in 
the same way. 

 

A LabSTAF unit takes around 30 s to boot up and attach to RunSTAF. This is a fully automated 
process which includes the uploading of stored calibration data from the LabSTAF unit and scs data 
file. 
See: LabSTAF calibration 

   

For this demonstration, sample exchange between 
successive FLCs has been activated by pressing the 
button next to Exchange. 

In addition, the sample prime function has been 
activated through the menu bar… 

Settings → Prime the sample chamber on run 

 FLC setup 

STAF setup and → 
STAF data 
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4.3 Starting acquisition – the pre-FLC functions 

 

The Start acquisition button appears once 
the boot up sequence has completed. 
The Sample and System temperatures are 
updated every second or so. 

 

Pressing the Start acquisition button 
starts the LabSTAF programming 
sequence. Because the sample prime 
function is active, the Auto LED step is 
interrupted by the sample exchange 
sequence. 

 

The first step is Exchange (flow). Solenoid 
A is switched from the default condition of 
Normally Open (NO) to Normally Closed 
(NC) immediately before the peristaltic 
pump starts. 
The From start value is reset to zero at 
each step. 

 

Once the flow phase has completed, the 
peristaltic pump is stopped. 
The next step is Exchange (purge). 
Solenoid A is switched back to the NO 
state immediately before the pump 
restarts. 

 

Once the purge step has completed, the 
peristaltic pump is stopped, and the Pre-
FLC light and/or dark phases are run (if 
active). In this case, the light step has been 
set to zero and the dark step has been set 
to 20 s. 
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The next step is Auto LED which 
incorporates the Auto PMT function 

 

In this example, the Auto DWC option is 
active. Three DWC reps are run after the 
Auto LED step. 
See: Package Effect Correction (PEC) 

 

The Auto PEP option is also active. Three 
PEP reps are run after the Auto LED and 
DWC step.  
See: Photochemical Excitation Profile 
(PEP) 

4.3.1 STAF setup 

 

The protocol set for these measurements includes the 
dual ST pulse function with the default option of 100 
µs pulses and six gap steps between 200 and 6400 µs. 

 

The second ST pulse (2nd pulse) is automatically set to 
zero while the Auto LED, Auto DWC and Auto PEP 
functions are running. 
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The Auto LED function runs first. This adjusts the EST 

values for non-zero channels to aim at the Target PII 
value. In this example, the EST values for the two 452 
nm channels have been decreased. These values are 
used for the DWC function. 

 

The Auto PEP function sets appropriate EST values for 
all eight channels.  
See: Photochemical Excitation Profile (PEP) 

 

Once the Auto PEP function has completed, the 
second ST pulse is set back to its original value and the 
EST values previously set by the Auto LED function are 
implemented. 
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4.4 Switching between the PEP and the most recent ST curve 

If the Auto PEP function is run, the PEP generated is shown on the home screen by default. Once the 
FLC starts, the most recent ST curve can be shown in place of the PEP by pressing the Show ST curve 
button. Pressing the Show PEP button returns to the PEP.  

  

4.4.1 The data screen during Auto FLC mode 

 

The Show data plots button appears at the 
bottom right of the home screen once the FLC 
has started. Pressing this button switches the 
view to the data screen. 

The screenshot below shows the data screen with the default selections active (Show tau data, 
Traces on and Rho fits on). The two plots on top show a dual pulse ST acquisition, while the lower 
plot window shows the actinic LED protocol implemented during this FLC as a white line. 

 

Pressing the Show plot selections button reveals the range of plot options.  
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Most plot selection labels are appropriate for a dark-adapted sample. In the example below, PII and 

sPII are selected as green plots with the latter as a dashed line. Fv/Fmc is plotted in solid red. For 

light measurements, PII' and sPII' and Fq'/Fmc' are plotted with the same pens. 
See: Glossary of terms 

 

Pressing the Hide plot selections returns the top half of the view to the ST pulse or pulse pair.  

In the next example, the Dimer fits on and Dimer centres on options have been activated. The 
Dimer fits are shown as yellow traces. The green, purple and red traces track the proportions of 
dimers in the open-open (oo), open-closed (oc) and closed-closed (cc) states, respectively. For a 
homogeneous population of cells, the Rho and Dimer fits generate very similar curves. The data 
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shown were recorded from culture cells of the marine diatom, Phaeodactylum tricornutum. 
See: The Rho ST curve fit and The Dimer ST curve fit 

 

4.5 The relaxation phase fit 

Pressing the Show tau data button switches the top panel to show a plot of the relaxation phase 
data. The first screenshot below shows the default tau data fit (Rho selection).  

 

The next screenshot shows the Fv, Rho and Dimer tau fits. The Fv plot tracks the recovery back 
towards Fv or Fq' with the increasing gap between the first and second ST pulses in a dual pulse 
sequence. Rho and Dimer fits track the reopening of PSII reaction centres between the first and 
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second ST pulses. Each plot value is the proportion of centres closed by the first ST pulse that are still 
in the closed state at the start of the second ST pulse. 

 
See: Fitting a dual ST pulse sequence  

4.6 FLC setup 

The Auto FLC option under FLC setup is active in this example. The next screenshots show how this 
option operates during a sequence of FLCs. The first screenshot shows a completed FLC with the 
Show rPE selections button pressed. The red line and symbols show the actual data values while the 

white line shows the curve fit used to generate the reported values of , Ek,  and rPm. 
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In the screenshot below, the plot options for JPII, ' and ' have been selected for display as lines 
without symbols. 

 

In the next screenshot, the Hide rPE selections button has been pressed, hiding the plot options on 
the left hand side of the plot. Within the plot, the closest point to Ek has been selected, indicated by 
the vertical line. Values corresponding to this photon irradiance are now displayed on the right. 

 

If the Auto FLC option is active, the High E value is automatically adjusted to four times the Ek value 
from the previous FLC. In this example, the previous FLC (above) has an Ek of 220.7 µmol photons 
m-2 s-1 which has been rounded up to 221 µmol photons m-2 s-1 on the screen. Consequently, the 
High E value for the next FLC (at Step 12 in the screenshot below) is set to 883 µmol photons m-2 s-1. 
The next two completed FLCs in the sequences are shown below. 
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4.7 Archiving of data 

Completed data files are automatically archived with a timestamp as the filename (YYMMDD 
followed by the time in 24 h format). Within the example in Figure 4.2, the first file generated is 
named 201220-1233 indicating that the FLC started on 20th December 2020 at 12:33 pm.  

…\Documents\CT-RunSTAF\Data files\ 



Page 30 of 116 
 

 

Figure 4.2: Screenshot from 
the Auto-saved sub-folder 
showing consecutive files.   
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5 An introduction to the Manual mode 

The manual mode is set by selecting… 

Settings → Acquisition mode → Manual 

Switching the mode from Auto FLC to Manual allows for more settings to be changed during an 
experiment. The screenshot below shows the RunSTAF home screen with the manual mode selected 
and the RunSTAF unit attached. 

 

The STAF setup and Data processing sections are identical for both the Auto FLC and Manual modes. 
The Manual settings section provides real time control of LabSTAF functions. 

 

In this first step, data were 
acquired for a basic check with the 
Auto DWM and Auto PEP both set 
as Inactive.  

The Auto LED and Auto PMT were 
left as Active. 

 

After the Start acquisition button 
was pressed, the system ran 
through the Auto LED function 
and started acquiring data. Here, 
the most recent Saq is shown on 
the home screen. 

 Manual mode only 

Auto FLC and → 
Manual modes 
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The next step was to restart 
acquisition with the Auto DWM 
and Auto PEP both set as Active. 

This crop from the home screen 
was acquired while the PEP was 
running (after the DWM had 
completed).  

 

This crop from the home screen 
shows the completed PEP with 
Show SCS active. 

On the data screen, the only difference between the two acquisition modes is the absence of the FLC 
step field when in Manual mode. 

 

 

All Manual settings are available 
during data acquisition. In this 
example, the PMT waveband has 
been switched from HC685 ± 10 nm 
to 730 ± 10 nm. 

 



Page 33 of 116 
 

6 STAF setup and STAF data 

 

The STAF setup and Data 
processing options are 
available within both 
acquisition modes. 

This crop from the home 
screen shows the options 
available before acquisition has 
started. 

 

This crop from the home 
screen shows the STAF setup 
and Data processing sections 
for a completed file with the 
Set Fv/Fmc and Apply DWM 
options both set to No. 

 

Here, the Set Fv/Fmc and Apply 
DWM options both set to Yes. 

 

With the Apply DWM option set to No, the PEC value can be edited. With the Apply DWM option 
set to Yes, the PEC value is generated by the DWM function and cannot be edited. 

6.1 STAF setup section 

All settings in the left column of STAF setup are for the MLEDs. If Auto LED is active, the Set PII 
value provides the target initial slope of RCII closure during the first ST pulse. The value of 0.056 in 
the above example is equivalent to 5.6% of the RCII population in the open state at t = 0 being closed 
by t = 1 µs. The Auto LED function adjusts the photon flux from the MLEDs to try and achieve the 

requested PII value. LED channels set to zero by the user are left unchanged. 

The editable value for each of the eight MLED channels is the photon flux delivered to the 
interrogated volume by each LED channel with units of photons nm-2 (100 µs) -1. The Total EST field 
provides the sum of values from all active channels. 1.0 photons nm-2 (100 µs)-1 is equivalent to 
16,603 µmol photons m-2 s-1. 
See: Auto LED 

The top two settings in the right column of STAF setup set the Auto PMT function and the starting 
PMT eht. The Auto PMT function is set to Active every time RunSTAF is started. 
See: Auto PMT 

Below the PMT settings are the 1st Pulse, 2nd Pulse, Start gap, End gap and Gap Steps fields for the 
dual ST pulse relaxation phase. The default ST pulse duration is 100 µs for both pulses. The start gap, 
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end gap and gap steps values collectively define the sequence of gaps between the end of the first 
pulse and the start of the second pulse. The first and last gaps are always as set. RunSTAF fills in the 
intermediate values such that the increase between successive gap lengths is always by the same 
factor. For example, the default gap sequence (as shown in the above example) is 200, 400, 800, 
1600, 3200 and 6400 µs. The relaxation phase analysis is based on the recovery of variable 
fluorescence between the first and second ST pulses. 
See: The relaxation (tau) phase fit 

The Sequence interval value sets the interval between the end of one sequence and the start of the 
next. When the dual pulse method is being used, this is between the end of the second ST pulse for 
one sequence and the start of the first ST pulse for the next sequence. 

The Seq / Acq and Acq / Saq values define the level of signal averaging. 

6.2 Data processing 

 

The Data processing section of the home screen facilitates correction 
for baseline fluorescence (Fb), setting the value of Ka and correction for 
the package effect. 

The first elements (Set Fv/Fmc and Value) control baseline correction by setting an assumed intrinsic 
value of Fv/Fmc for PSII complexes that incorporate photochemically active RCIIs. 
See: Correcting for baseline fluorescence (Fb calculation) 

The next element in the Data processing column is Ka. Calculated values of JVPII and GOPII are in 
direct proportion to the set value of Ka. If the value is changed by the user, the new value is 
immediately applied to values of JVPII and GOPII. All Clipboard and csv functions that incorporate 
calculated values of JVPII and GOPII include the applied value of Ka. 
See: Generating values of JPII, JVPII and GOPII 

The Auto DWM function runs the Dual Waveband Measurement function when active. 

The PEC field sets the value for Package Effect Correction. As shown above, the PEC value is only 
editable when Apply DWM is set to No. The calculated values of JVPII and GOPII are inversely 
proportional to the PEC value. 
See: Package Effect Correction (PEC) 
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6.3 The automated RunSTAF functions 

 

When data acquisition is 
started, the active automated 
functions are run in the order 
shown below. 

6.3.1 Auto PMT 

Auto PMT is always active when RunSTAF is started. There is generally no reason to deactivate this 
function, which optimises the dynamic range of signal detection by adjusting the PMT eht (V). 
Throughout the experiment, the function continuously monitors the fluorescence signal and ensures 
that it is kept within dynamic range of the PMT. The value set within the PMT eht field is the first 
value tried when the Run acquisition button is pressed. The upper and lower limits for the PMT eht 
are 800 V and 360 V, respectively. The change in sensitivity of the PMT approximates to a doubling 
for every 40 V increase in the PMT eht (a factor of 2048:1 between 360 V and 800 V).  

6.3.2 Auto LED 

This function adjusts the output of all MLED wavebands that are set to non-zero values. In the above 
example, both 452 nm channels are set as 0.72. RunSTAF adjusts the output of both wavebands in 

proportion to the value set by the user to achieve the Target PII value. These settings are used 
during the Auto DWM function (if active) and while running the FLC. The Auto LED function will 
always run if the Auto DWM or Auto PEP is active. 

6.3.3 Auto DWM 

This function measures Fv three times with each of the 685 nm or 730 nm bandpass filters (both ±10 
nm FWHM) located in front of the PMT. Primary DWM data can be accessed through a Clipboard 
function: 

Clipboard → DWM data  

See: Package Effect Correction (PEC) 

6.3.4 Auto PEP 

If this function is active, RunSTAF will work through a set protocol to generate the PEP as relative 

photon yield values of Fv and values of PII for all seven wavebands. The primary PEP data can be 
accessed through a Clipboard function: 

Clipboard → PEP data  

The emission spectra for the seven MLED wavebands and the ALED can also be accessed through a 
Clipboard function: 

Clipboard → SCS data  

See: Photochemical Excitation Profile (PEP) 



Page 36 of 116 
 

7 The FLC setup 

 

This screenshot shows the FLC setup 
section of the home screen. The left 
column provides a range of options for 
setting up the FLC, sample mixing, sample 
exchange and running a wash cycle. The 
right side of the FLC setup shows the E 
values (µmol photons m-2 s-1) generated 
by the Steps, High E and Push up values 
entered in the left column and the set 
time for each of the steps. 

The sequence starts by running through 
the Up column. A non-zero Dark period is 
implemented after the Up value at the 
same Step. The Down column is run in 
reverse order after the Up column and 
non-zero Dark values have all been 
implemented. 

7.1 Elements of the FLC setup 

Step max: defines how many Gaqs are used to define each rPE fit and step data value 

Pre-FLC E: photon irradiance for a pre-illumination step (µmol photons m-2 s-1) 

Light time: time at the Pre-FLC E (s) 

Dark time: time in the dark after the Pre-FLC E step (s) 

Steps: number of steps for the FLC 

High E: highest actinic photon irradiance for the FLC (µmol photons m-2 s-1) 

Push up: rate at which the photon irradiance increases through the Up steps 

Run time: minimum time that the FLC will take to run 

Mix: injects air between FLC steps when active  

Exchange: runs a sample exchange cycle when active 

Repeat FLC: starts a new FLC after each FLC completes when active 

Auto FLC: optimises the High E value between successive FLCs when active 

Wash cycle: runs the programmed wash cycle when active 

Interval: time between successive wash cycles (h) 

Clean time: using the cleaning fluid connected to the NO port of solenoid valve C (s) 

Rinse time: using the cleaning fluid connected to the NC port of solenoid valve C (s) 

7.2 The maximum step function (Step max) 

The rPE fit and step data values are averages from the last Gaqs at each FLC Step. The Step max 
defines how many Gaqs are included within the average. For example, if the Group time (shown 
under STAF setup on the home screen) is 6 s and the step max value is 20 s, the last three Gaqs at 
each step will be processed. Increasing the Step max value to 24 s would result in the last four Gaqs 
being included. 

By excluding the first Gaqs at each step, the parameter values can be pushed towards steady-state. 
When the Step max value is changed, all rPE step data are recalculated immediately. 
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7.3 The Pre-FLC function 

The Pre-FLC E, Light time and Dark time fields can be used to implement pre-illumination and dark 
acclimation steps before the FLC starts. Either step can be skipped by setting the time to zero. Data 
are not logged during these steps, which are run before the Auto LED, Auto DWM and Auto PEP 
functions. The Pre-FLC function has primarily been incorporated to facilitate low light-induced 
relaxation of non-photochemical quenching which is widely observed in diatoms and cyanobacteria 
(e.g. Lavaud and Goss, 2014; Lacour et al. 2018).  

When the Pre-FLC E value is set to a low value (below 20 µmol photons m-2 s-1) the relationship 
between drive current and photon output becomes temperature dependent. To ensure that the 
actual output from the ALED is as close as possible to the requested value, a photodiode-monitored 
feedback loop has been incorporated. The same feedback loop is used to set low Step E values 
within Auto FLC protocols. 

 

In this example, the requested Pre-FLC E 
value was set to 10 µmol photons m-2 s-1. This 
was low enough to trigger the photodiode-
monitored feedback loop to set the closest 
Set E value possible. The starting value was 
29.4 µmol photons m-2 s-1. 

 

After automated adjustment, the Set E value 
was set at 12.2 µmol photons m-2 s-1. 

7.4 The push up function 

 

The Push up function 
determines the distribution 
of E values within the FLC. 
Increasing the value pushes 
the distribution towards 
High E. The examples below 
show the extremes of 24 
(left) and 240 (right). 

7.5 Run time 

Once the set step time has been reached, RunSTAF will complete the existing Saq group before 
switching to the next step. If the Group time is long (to compensate for very low biomass, for 
example), the actual run time can be significantly longer than the value shown under Run time. 
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7.6 The Mix function 

When active, the peristaltic pump runs for the On time at the set Speed. The Mix function can be 
implemented with or without the solenoid unit being plumbed in. This function can be run with the 
flow-through unit or the flow-through stirrer unit. 

7.7 The Exchange function 

When active, this function is triggered at the end of an FLC. The solenoid unit and peristaltic pump 
must both be plumbed in. There are two stages to the Exchange cycle. During the first stage, the 
peristaltic pump runs for the set Flow time with Solenoid A set to NC. This displaces the existing 
sample with a new sample. For the second stage, Solenoid A returns to NO and the peristaltic pump 
runs for the set Purge time. This clears all plumbing after the solenoid valve.  

7.8 Repeat FLC 

If this function is active, FLCs are run continuously. If the exchange function is also active, the sample 
is exchanged between the end of one FLC and the start of the next. The FLC that has just finished is 
archived and a new data file is generated for the next FLC. 

7.9 Auto FLC 

When active, the High E value is set to four times the Ek from the previous FLC, to a maximum of 
2000 µmol photons m-2 s-1. 

7.10 Wash cycle 

When active, this function is triggered at the end of the first FLC to complete after the set Interval is 
reached. During the first stage of the cleaning cycle, set by the Clean time, Solenoids A and B are 
both set to the NC position. During the second stage of the cleaning cycle, set by the Rinse time, all 
three solenoids are set to the NC position. If the Wash cycle and Exchange functions are both active, 
the Wash cycle runs first. 
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8 Manual settings  

  

Manual settings provides real 
time control over a range of 
LabSTAF system functions 
when the Manual acquisition 
mode is active. 

 

Pause acquisition halts data input when turned On and resumes acquisition when turned off. 

PMT waveband manually exchanges the bandpass filter in front of the PMT. If the default of 
HC685 ± 10 nm is clicked, it changes to HC730 ± 10 nm. 

The Actinic field can be edited to set the required incident photon irradiance provided by the ALED. 

Solenoid A, B or C: The NO to COM values are Normally Open to Common. This is the default 
(unpowered) state. The powered state is NC to COM (Normally Closed to Common). 

Pump turns the peristaltic pump On and Off. The pump runs at the set Speed (1 – 16). 

Mix Runs the peristaltic pump when active. The pump runs for On time at the set Speed (1 – 16) and 
Interval. 

Auto archive automatically archives data to a timestamped file when Active. The interval between 
files is set by the New file every value. 
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9 Data export functions 

9.1 The Clipboard functions 

The Clipboard menu provides options for accessing primary and processed data in a range of 
different formats.  

 

When a Clipboard function is run, the dialog shown below will 
open once the data array has been constructed. When this 
message is closed, the data are written to the Clipboard in a tab-
delimited text format. This format is suitable for pasting directly 
into Excel and many other spreadsheet-based applications. 

9.1.1 The Clipboard header 

A header with the format shown below is incorporated within all Clipboard functions. 

 

9.1.2 The Clipboard footer 

The same footer format is used by all Clipboard functions. It provides a record of the calibration 
values used at the time the data within the file were acquired. 

See: LabSTAF calibration 
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9.1.3 DWM data 

Accessed through Clipboard → DWM data 

The dataset copied to the Clipboard includes the trace data used to generate the DWM value. Either 
this value or a user-set value is used for Package Effect Correction (PEC). In the example shown 
below, the data have been pasted into Excel and a plot has been generated by the user. 

See: Package Effect Correction (PEC) 
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9.1.4 PEP data 

Accessed through Clipboard → PEP data 

The dataset copied to the Clipboard includes the trace data used to generate the Fv and SigmaPII 
values for each of the seven MLED wavebands. In the example shown below, the plots have been 
generated by the user within Excel. 

See: Photochemical Excitation Profile (PEP) 
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9.1.5 SCS data 

Accessed through Clipboard → SCS data 

This function copies the Actinic LED (ALED) emission spectrum plus the Fv and SigmaPII absorption 
spectra at 1 nm resolution. In the example shown below, the plots have been generated by the user 
within Excel. 

 

See: Photochemical Excitation Profile (PEP) 

9.1.6 rPE data 

Accessed through Clipboard → rPE data 

The dataset copied to the Clipboard includes JVPII and GOPII values generated using the Absorbance 
method plus JPII values generated using the Sigma method. In the example shown below, the data 
have been pasted into Excel and a data plot has been generated within Excel. The Gaq traces used to 
generate the rPE values are also included within the output. 
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9.1.7 Tau data 

Accessed through Clipboard → Tau data 

The dataset copied to the Clipboard includes time constants and amplitudes for the Fast and Slow 
phases for each of the three fitting methods used within RunSTAF to fit the relaxation kinetics (Fv, 
Rho and Dimer). The F (fast) values are linked to RCIIs with a plastoquinone or semi-plastoquinone 
bound at the QB site at the end of the first ST pulse in the dual pulse sequence. The S (slow) values 
are linked to RCIIs with an empty QB site at the end of the first ST pulse in the dual pulse sequence. 
Values for all parameters are calculated for every group within the file. 
See: Data processing within RunSTAF 

 

9.1.8 Saq parameters or Acq parameters  

Accessed through Clipboard → Saq parameters or Clipboard → Acq parameters 

This copies values for a wide range of derived and primary parameters to the Clipboard. 

  → 

→ 

 →… 
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9.1.9 Saq traces or Acq traces  

Accessed through Clipboard → Saq traces or Clipboard → Acq traces 

The main purpose of this function is to copy the primary Saq or Acq trace data to the Clipboard. 
Above the trace data, a range of calculated parameters are provided in a vertical format, as shown in 
the left screenshot below. The trace data include the baseline. The timescale (the µs column in the 
right screenshot below) shows the baseline values as negative. The 0 value in the µs column is t = 0 
for the first ST pulse.  

  
 

… 
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9.1.10 Saq trace fits or Acq trace fits (Rho) 

Accessed through Clipboard → Saq trace fits (Rho) or Clipboard → Acq trace fits (Rho) 

Each ST trace is accompanied by the RunSTAF-generated Rho fit (Fit 1, Fit 2…) and an associated 
column showing the accumulation of closed RCIIs through the ST trace (C 1, C 2…). 

 

9.1.11 Saq trace fits or Acq trace fits (dimer) 

Accessed through Clipboard → Saq trace fits (dimer) or Clipboard → Acq trace fits (dimer) 

Each ST trace is accompanied by the RunSTAF-generated Dimer fit and concentration curves for the 
three dimer forms: the [oo], [oc] and [cc] labels correspond to the fractions of dimers within the 
sample in the Open-Open, Open-Closed and Closed-Closed states respectively. 
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9.2 The csv functions 

Accessed through File → csv files 

9.2.1 All file and Individual files 

The Folder-based PEP file, Folder-based rPE file and Folder-based Saq file options create a single csv 
file generated by extracting data across all files within the selected folder. The Individual rPE files 
and Individual Saq files options generate a csv file for each RunSTAF data file.  

Selecting any of the csv files by folder options opens a file dialog. Double-clicking on any file within 
the folder triggers the selected function. 

The screenshot below shows a folder containing six RunSTAF data files. All csv functions have been 
run on this folder to generate the csv files. The naming for these files is automatic. The Folder-based 
PEPs, Folder-based rPEs and Folder-based Saqs file names comprise the timestamp for the most 
recent file in the folder plus All PEPs, All rPEs or All Saqs.  
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Example Folder-based PEP file. The plots were generated within Excel. The ALED normalized values 

are the MLED waveband values of Fv and PII normalized to the ALED values for each parameter. 

 → 
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Example Folder-based rPE file… 

 

Example Folder-based Saqs file… 
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9.2.2 Auto archive report line 

Activated through File → csv files → Auto archive report line 

This function generates a simple summary csv file each time a RunSTAF data file is completed. The 
default comma used to separate adjacent values can be switched to a tab or semicolon. 

Accessed through File → csv files →Field separator for csv output 

The report line csv has the same filename as the associated RunSTAF data file.  

 

Example Auto archive report line file… 

 

→   



Page 51 of 116 
 

10 Data processing within RunSTAF 

10.1 Refitting data files 

The structure of RunSTAF data files allows for the refitting of primary data. Where appropriate, 
updated fits are applied to older RunSTAF data files as they are opened. In extreme cases, refitting a 
single file can take tens of seconds. RunSTAF includes two functions to run a bulk refit on all files 
within a folder to avoid any delay as individual files are opened. 

The refit functions can be accessed through File → Run a folder-based Saq refit and File → Run a 
folder-based Acq refit. When either function is run, the home screen reports progress on the 
refitting process (Figure 10.1). 

 

Figure 10.1: Crop from a screenshot of the home screen 
taken while a folder-based Acq refit is running. 

RunSTAF does not report Acq parameters derived from curve fits. Consequently, it only makes sense 
to run the Acq level refit if you need access to primary data at the Acq level (through the Clipboard 
functions). 

If you move away from the RunSTAF window while a refit is running, you are likely to get a ‘RunSTAF 
not responding’ message. This message can usually be ignored as data processing will normally 
continue in the background. Once the refit has finished, RunSTAF will open a dialog with the 
message Refit completed. 

10.2 Correcting for baseline fluorescence (Fb calculation) 

The fraction of Fo that does not originate from photochemically active PSII complexes is termed 
baseline fluorescence (Fb) and the fraction that does is termed baseline corrected Fo (Foc). An 
estimated value for Fb can be calculated using Equation 10.1. 

 Fb = Fm −
Fv

(Fv Fmc⁄ )
 Equation 10.1 

Where Fv/Fmc is the assumed 'intrinsic' value for photochemically active PSII complexes within the 
sample. 

Within a study conducted by Boatman, Geider and Oxborough (2019), an Fv/Fmc of 0.518 generated 
a good match between STAF-generated estimates of GOPII and more direct estimation of GOPII using 
a Clark-type O2 electrode. Although a value of 0.518 is unlikely to be appropriate in every 
circumstance, these data do indicate that it may be possible to extrapolate from a relatively small 
number of direct measurements of GOPII across a much wider dataset of STAF-derived values. 

10.3 The ST curve fitting procedures 

The default RunSTAF ST pulse is 100 µs. Data are acquired at 1 MHz starting 20 µs before the ST 
pulse is triggered and running through to the end of the pulse. If a second ST pulse is included within 
a Seq (dual ST pulse mode), data are also acquired for the entire duration of this pulse. No data are 
acquired during the gap between the first and second ST pulses. 

Although the first ST pulse is always triggered 20 µs into the sequence, it takes approximately 3 µs 
after this trigger for the MLEDs to get to full output. Table 10.1 shows typical MLED output data for 
the first 4 µs after the ST pulse is triggered. 
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t (µs) ST fit t (µs) delivery sum 

1  -1 << 1% << 1% 

2 0 30% 30% 

3 1 80% 110% 

4+ 2+ 100% - 

Table 10.1: All curve fitting functions within RunSTAF use an offset of 2 µs. Working from the values presented 
here, this means that at t = 1 µs for the ST fit, the sample will have received 110% of the photons normally 
delivered in 1 µs. This 110% value is the sum of 80% delivered between t = 0 and t = 1 and 30% between t = -1 
and t = 0 on the ST fit scale. 

10.3.1 The Rho ST curve fit 

The ST curve fitting procedure within RunSTAF is centred around Equations 10.2 and 10.3 (Kolber, 
Prášil and Falkowski, 1998). 

 𝐶𝑡 = 𝐶𝑡−1 + 𝐶𝑡=1 ∙ (1 − 𝐶𝑡−1) (1 − 𝐶𝑡−1 ∙ 𝜌)⁄  Equation 10.2 
 
 F𝑡 = Fo + Fv ∙ 𝐶𝑡 ∙ (1 − 𝜌) (1 − 𝐶𝑡 ∙ 𝜌)⁄  Equation 10.3 

 
Where F𝑡 is the fluorescence intensity at time t, 𝐶𝑡 is the fraction of closed reaction centres at time t, 
𝜌 (Rho) accounts for connectivity between RCIIs, and Fv = Fm – Fo. It is assumed that 𝐶 = 0 at t = 0. 

During the fit, 𝐶𝑡=1, , Fo and Fm are all allowed to float. Adjacent values of t are always 1 µs apart (1 
MHz acquisition). The connectivity parameter 𝜌 accounts for the transfer of photons from closed 
RCIIs to open RCIIs. 

The value of 𝐶𝑡=1provides the initial rate at which photons are used to drive PSII photochemistry 

during a ST pulse (PII). For the LabSTAF system, 𝐶𝑡=1defines the proportion of PSII complexes at 
which a photon was absorbed and used to drive PSII photochemistry during the first microsecond of 

the ST pulse. It follows that PII has units of photons PSII-1 µs-1. 

The value of PII can then be generated using Equation 10.4. 

 σPII = αPII ∙ 100 EST⁄  Equation 10.4 
 

This provides a value for PII with units of nm2 PSII-1. 

Although Equations 10.2 and 10.3 use terminology appropriate to a dark-adapted sample, these 
equations can also be applied to a light-adapted sample. This is because the term 𝐶 within these 
equations is always set to zero at t = 0 under ambient light, even though a proportion of PSII reaction 
centres within the sample are closed at t = 0. The reason for this is that Equations 10.2 and 10.3 only 
track the closure of PSII reaction centres that are open at t = 0 and implicitly assume that the 
proportion of PSII centres held in the closed state by the actinic light remains constant throughout 
the ST pulse. Equations 10.5 and 10.6 provide the light-adapted versions of Equations 10.2 and 10.3. 

 𝐶𝑡 = 𝐶𝑡−1 + 𝐶𝑡=1 ∙ (1 − 𝐶𝑡−1) (1 − 𝐶𝑡−1 ∙ 𝜌′)⁄  Equation 10.5 
 
 F𝑡′ = F′ + Fq′ ∙ 𝐶𝑡 ∙ (1 − 𝜌′) (1 − 𝐶𝑡 ∙ 𝜌′)⁄  Equation 10.6 

10.3.2 The Dimer ST curve fit 

It is now widely accepted that photochemically active PSII complexes form structural dimers within 
thylakoid membranes (e.g. Nield and Barber, 2006; Watanabe et al. 2009; Umena et al. 2011) and it 

seems likely that this dimerization can at least partially account for the connectivity defined by  in 
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Equations 10.5 and 10.6. The dimer curve fit incorporated within RunSTAF makes the following basic 
assumptions: 

• All functional PSII reaction centres are incorporated within dimeric complexes and the two 
reaction centres within each dimer effectively share a single light harvesting system 

• PSII dimer complexes are completely isolated from each other, preventing the transfer of 
photons from one dimer to another 

With these assumptions in place, the following Equations can be used to fit the first ST curve in a 
dual ST measurement from dark-adapted samples: 

 [oo]𝑡 = [oo]𝑡−1 − [oo]𝑡−1 ∙ 𝐶𝑡=1 Equation 10.7A 

 [oc]𝑡 = [oc]𝑡−1 + [oo]𝑡−1 ∙ 𝐶𝑡=1 Equation 10.7B 

 [oc]𝑡 = [oc]𝑡−1 − [oc]𝑡−1 ∙ 𝐶𝑡=1 ∙ 0.5 (1 − 0.5 ∙ 𝜌)⁄  Equation 10.7C 

 [cc]𝑡 = [cc]𝑡−1 + [oc]𝑡−1 ∙ 𝐶𝑡=1 ∙ 0.5 (1 − 0.5 ∙ 𝜌)⁄  Equation 10.7D 
 
 ooF = [oo] ∙ Fo Equation 10.8A 

 ocF = [oc] ∙ (Fo + Fv ∙ 0.5 ∙ [1 − 𝜌] [1 − 0.5 ∙ 𝜌]⁄ ) Equation 10.8B 

 ccF = [cc] ∙ Fm Equation 10.8C 
  

Within Equations 10.8A-C, ooF, ocF, and ccF are the relative fluorescence intensities from [oo], [oc], 
and [cc] dimers, respectively. Because the two reaction centres within each dimer are assumed to 

share a single light harvesting system, 𝜌 is theoretically equal to PII. 
See: Deconstructing rho 

For the second ST curve in a dual ST sequence and measurements from light-adapted samples, the 
Dimer fit requires initial (t = 0) values for [oo], [oc] and [cc]. These values are estimated by assuming 
that [cc] equals unity at the asymptote of the ST fit (Fm or Fm'). 

It is worth noting that heterogeneity has a larger impact on the Dimer fit than the Rho fit. This is 
particularly true when a sample contains significant proportions of cells with very different values of 
Ct = 1 in the above equations. Mainly for this reason, the Dimer fit is only used to generate 
parameters that directly relate to this fitting process (within the Dimer fit parameters section of the 
data screen). All other parameters that have dependence on a ST curve fit (within the Rho fit 
parameters, Primary fluorescence values, Relaxation phase parameters (Rho) and Baseline 
corrected parameters sections) are generated using the Rho fit. 

10.4 Fitting a dual ST pulse sequence 

The screenshot below shows a dual ST pulse Saq from a dark-adapted sample. The gap applied 
between the first and second ST pulses in this example was 200 µs. The small orange numbers in the 
bottom right corner of each ST plot is the number of points incorporated within the Rho and Dimer 
fits. The first ST pulse fit was to the first 68 points. Over the last part of the curve, there is a clear 
decrease in fluorescence which was excluded from the fit. The second ST pulse was fit to all 96 
available points. 

The observed decrease in fluorescence towards the end of the first ST pulse tends to be most 
evident when the ratio of variable fluorescence to total fluorescence is relatively high (above 
approximately 0.5). The decrease in fluorescence towards the end of the first ST pulse is correlated 
with an absorption change centred at 515 nm (Witt, 1971) which tracks the rapid formation of an 

electric field across the thylakoid membrane () as most of the RCIIs within the interrogated 
volume undergo charge separation within the timeframe of the ST pulse. To minimise the impact of 
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this electric field-dependent quenching on the Rho curve fit, the part of the algorithm that 
determines the number of points to be fit incorporates Fv/Fm or Fq'/Fm' for the first ST pulse and 
sFq/sFm or sFq'/sFm' for the second ST pulse. 

Within the example provided by Figure 10.2, the first ST pulse is fit to 68 points because the value of 
Fv/Fm is high (0.572). The second ST pulse is fit to all 96 points because sFq/sFm is much lower 
(0.203). The overall result is consistent with the amplitude of the electric field-dependent quenching 
evident at the end of the first ST pulse being increased by charge separation during the second ST 
pulse. As a result, sFm is significantly lower than Fm. 

 
Figure 10.2: Crop from a screenshot of the data screen showing a dual ST pulse. The gap interval was 200 µs. 

Figure 10.3 shows an entire dark group from which the example in Figure 10.2 was extracted. 

  
Figure 10.3: Composite of crops from screenshots of the data screen showing curves from a complete dual ST 
pulse Set. The target sample was dark adapted. The times shown are the gap intervals. The numbers within 
brackets are % recovery of variable fluorescence between the first and second ST pulse. 
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Working through the gap intervals from shortest to longest, there is a consistent increase in sFm, 
relative to Fm. At 200 µs, sFm is noticeably lower than Fm. By 1600 µs, sFm is slightly higher than Fm 
and by 6400 µs sFm is very noticeably higher than Fm. The relative increase in sFm is consistent with 
neutralisation of the electric field-dependent quenching between the end of the first ST pulse and 
the start of the second ST pulse with a time constant of around 1 ms (Witt, 1971; Johnson and 
Ruban, 2014). In addition, the increase in sFm to a point that is higher than Fm can be at least partly 
attributed to transient reduction of plastoquinone to semi-plastoquinone and semi-plastoquinone to 
plastoquinol as closed RCIIs are reopened through the transfer of electrons from reduced QA 
(Vernotte, Etienne and Briantais, 1979). 

For comparison, Figure 10.4 shows a group from the same sample under actinic illumination of 1000 
µmol photons m-2 s-1. Recovery of variable fluorescence is broadly in line with the dark group shown 
above. One important difference is that the electric field-dependent quenching evident in the dark 
group is not evident within this group. This can be attributed to the much smaller number of RCIIs 
undergoing charge separation during the first ST pulse. In contrast, sFm is very slightly higher than Fm 
between 1600 and 6400 µs. This is consistent with short-lived formation of plastoquinol as this 
relatively small pool of RCIIs reopen. 

 
Figure 10.4: Composite of crops from screenshots of the data screen showing curves from a complete dual ST 
pulse Set. The target sample was under actinic illumination of 1000 µmol photons m-2 s-1. 

10.5 The relaxation phase (tau) fit 

Three relaxation phase fits are generated by RunSTAF: Fv, Rho and Dimer. The Fv fit tracks the 
recovery of variable fluorescence during the gap between the first and second ST pulses as 1 – 
sFq/Fv for a dark measurement or 1 – sFq'/Fq' under actinic light. The Rho and Dimer relaxation 
phase fits track the reopening of RCIIs during the gap between the first and second ST pulses using 
the Rho and Dimer models. All three fits use Equation 10.9 to generate values for comparison with 
the Fv, Rho and Dimer values. The fitting process minimises the sum of squares between values of Ft 
and actual data values at the same timepoint. 
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 F𝑡 = Fv ∙ (ΔF ∙ 𝑒
−

𝑡

𝜏F + ΔS ∙ 𝑒
−

𝑡

𝜏S) Equation 10.9 

Where the subscripts F and S refer to the fast and slow phases of the relaxation phase. The Fv within 
Equation 10.9 is correct for a single ST pulse or the first in a dual ST pulse sequence applied to a 
dark-adapted sample. For the second in a dual ST pulse sequence the appropriate term is Fq. For a 
light-adapted sample, the appropriate term for the first and second in a dual ST pulse sequence is 
Fq'. It is assumed that the fast phase is tracking the reopening of RCIIs with plastoquinone or semi-
plastoquinone bound at the QB site at the end of the ST pulse while the slow phase tracks the 

reopening of RCIIs with an empty QB site at the end of the ST pulse. F and S are the proportions of 
the total amplitude of the relaxation phase attributable to the fast and slow phases, respectively, 

while F and S are the time constants for these phases.  

The relaxation phase shown within the upper panel of the screenshot in Figure 10.5 is selected by 
moving the cursor in the lower panel. RunSTAF finds the group for the selected Saq and plots the 
curves for that Group. In the example below, the selected Saq was logged while the sample was in 
the dark. In the dark-adapted state, the separation of curves is usually as shown here: the Rho fit 
curve is above the Fv fit curve all the way through while the Dimer fit curve starts out with the Rho 
curve fit and then runs above it. 

 
Figure 10.5: Screenshot of the data screen with the Show tau data option active. 

With increasing actinic illumination, the Rho and Dimer fit curves both move closer to the Fv fit 
curve, as illustrated in Figure 10.6. This phenomenon can be attributed to connectivity between and 
among PSII complexes, as explained below. 
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Figure 10.6: Crops from 
screenshots of the data screen 
showing relaxation phase curve 
fits generated from dual ST 
pulse data acquired at the 
photon irradiances shown. 

The orange lines are the Fv fits, 
the teal lines are the Rho fits, 
and the yellow lines are the 
Dimer fits. 

In the absence of connectivity ( = 0), the Fv and Rho fits should match perfectly from the dark-
adapted state through to saturating actinic photon irradiance. The observation that the Fv, Rho and 
Dimer fit curves converge under increasing actinic photon irradiance is consistent with a decrease in 

the value of  (Rho model) and an increase in [oc] (Dimer model) as the proportion of RCIIs in the 
closed state increases.  
See: Deconstructing rho 

The bottom panel of the screenshot in Figure 10.7 shows plots of all five relaxation phase 
parameters from the Rho fit. 

 
Figure 10.7: Screenshot from the data screen showing all five relaxation phase parameters derived from the 
Rho fit. 
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With the fitting algorithm incorporated within RunSTAF, the total amplitude of the recovery phase 

(F + S) is always unity. The complete relaxation phase dataset for all three fits can be accessed 
through the Clipboard function… 

Clipboard → Tau data 

In addition to the parameter plots on the data screen,  from the Rho fit can be plotted within the 
rPE window on the home screen, as shown within Figure 10.8. 

 
Figure 10.8: Crop from a screenshot of the home screen showing the ' parameter within the rPE data plot. 

The ' values were generated from the Rho fit to ST data. 

10.6 The rPE data fit 

The rPE curve is a variant of the widely used photosynthesis – photon irradiance (PE) response 
curve. The 'P' in PE is generally taken to represent mass-specific photosynthesis (normalised to 
chlorophyll a, for example). In contrast, the rPE curve plots relative photosynthesis (rP). The 'E' in 
PE or rPE is always incident photon irradiance. Although values of rP are reported on a unitless 
scale within RunSTAF, they are actually calculated as the product of E and Fq'/Fmc'. This generates 
units of µmol photons m-2 s-1 which translates as µmol photons s-1 through a population of PSII 

complexes with a combined absorption cross section for PSII photochemistry (PII) of 1 m2. 

There are three basic parameters derived from all PE curve fits: , Ek, and Pm. The value of  
provides the initial slope of the relationship between P and E. Ek is an inflection point along the PE 
curve which is often described as the light saturation parameter (Platt and Gallegos, 1980). Pm is the 
maximum rate of photosynthesis. 

A range of models have been used to generate a fit to rPE and other PE curves (see Silsbe and 
Kromkamp, 2012 and references therein). The fitting method used within RunSTAF takes advantage 
of the fact that data points on the rPE curve up to Ek invariably have a higher signal to noise ratio 
than points after Ek. This is the opposite of the situation with 14C or O2-based PE curve datasets 
where the signal to noise tends to increase with photon irradiance up to Pm. Importantly, the 
reliance of the RunSTAF fitting procedure on a high signal to noise up to Ek makes it unsuitable for 
fitting 14C or O2-based PE data. To provide an example, Boatman, Geider and Oxborough (2019) used 
the procedure incorporated within RunSTAF to fit FLC-derived rPE data while the equations of Platt 
and Gallegos (1980) were used to fit data from PE curves generated from parallel O2 measurements. 
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There are two phases to the rPE fitting process incorporated within RunSTAF: the alpha phase and 
the beta phase. The fitting process is based around minimisation of the sum of squares (SS) of the 
difference between actual and fit values. The mean of the actual values at each E level are used for 
the fit. 

The alpha phase of the rPE fit uses the Webb model (Webb et al. 1974) to generate values for  and 
Ek. The value of Fq'/Fmc' used to generate each rPE value is calculated using Equation 10.10. 

 
Fq′

Fmc′
= α ∙ Ek ∙ (1 − 𝑒−E/Ek) ∙ E−1 Equation 10.10 

It follows that  is theoretically equal to Fv/Fmc and that Ek is the point on the rPE curve at which 
the value of Fq'/Fmc' is 63.2% of Fv/Fmc. For the alpha phase, the square of the difference between 
actual and fit values is multiplied by the square of the actual Fq'/Fmc' value at that point. This 
generates a fit that is heavily weighted towards low values of E and is the main reason why this 
approach is unsuitable for fitting 14C or O2-based PE curve data. 

The beta phase is generated using Equation 10.11. The beta phase is only applied to points after the 

Ek value generated by the alpha phase. This means that the values of  and Ek don’t change 
between the alpha and beta phases. 

 
Fq′

Fmc′
= (α ∙ Ek ∙ [1 − 𝑒−E Ek⁄ ] − β ∙ Ekβ ∙ [1 − 𝑒−E Ekβ⁄ ]) ∙ E−1 Equation 10.11 

The screenshot in Figure 10.9 shows the alpha phase fit to a complete rPE curve. The screenshot in 
Figure 10.10 shows the same fit with the beta phase added. 

 
Figure 10.9: rPE curve fit with the beta phase blocked such that the (solid white) rPE fit line is defined by 
Equation 10.10. 
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Figure 10.10: rPE curve fit with the beta phase applied such that the (solid white) rPE fit line is defined by 
Equation 10.11. 

 

  



Page 61 of 116 
 

11 Generating values of JPII, JVPII and GOPII 

The combination of LabSTAF hardware and RunSTAF software allows for measurement of JPII and 
JVPII using the so-called sigma and absorption methods respectively. Because the spectral output of 
the LEDs used for ST measurements (MLEDs) is very different from the spectral output of the LED 
providing actinic illumination (ALED) a spectral correction step is required for both parameters. In 
the case of JVPII, correction is also required for the package effect.  

This section covers some basic concepts underlying the sigma and absorption algorithms. Application 
of the Photochemical Excitation Profile (PEP) for spectral correction and Package Effect Correction 
(PEC) are covered in Sections 13 and 14. 

See: Photochemical Excitation Profile (PEP) and Package Effect Correction (PEC) 

Under the assumption that every photon used to drive PSII photochemistry results in the transfer of 
an electron from water to the plastoquinone pool, JVPII can be directly converted to Gross Oxygen 
release (GOPII) with SI units of mol O2 m-3 s-1. While GOPII can be derived from JVPII with reasonable 
confidence, processes operating within phytoplankton can uncouple PhytoPP from JVPII and GOPII 
(Geider and MacIntyre, 2002; Behrenfeld et al., 2004; Halsey et al., 2010; Suggett et al., 2010; 
Lawrenz et al., 2013). It follows that while JVPII can provide an upper limit for PhytoPP, the actual 
value may be significantly lower. 

The value of JVPII generated by STAF-based analysis is the product of the rate at which photons are 
absorbed by the PSII light harvesting system per unit volume and the proportion of absorbed 
photons used to drive PSII photochemistry. This value is defined as the PSII photochemical flux per 
unit volume because it is directly proportional to the absorption cross section of PSII photochemistry 
provided by all PSII complexes within each unit volume of ocean or other medium.  

11.1 Absorption cross section 

As a term, absorption cross section describes the probability of an absorption process. There are two 
processes intrinsic to PSII photochemical flux that are driven by the absorption of photons: 
formation of an excited state within the PSII pigment matrix (PSII light harvesting, LHII) and PSII 
photochemistry (PII). Within this document, the absorption cross sections for these processes are 

defined by the terms LHII and PII, respectively, with SI units of m2 PSII-1. Clearly, a photon can only 

drive PSII photochemistry after being absorbed. It follows that LHII is always larger than PII and 

that the relationship between LHII and PII is defined by the proportion of absorbed photons that 
are ultimately used to drive PSII photochemistry. The absorption process is illustrated by Figure 11.1. 

 
Figure 11.1: The absorption cross section of PSII light harvesting. A proportion of incident photons are 
absorbed and generate excited states within the pigment matrix.  
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At the simplest level, PSII photochemistry competes directly with two other absorption-dependent 
processes operating within the PSII complex: the loss of absorbed photons through thermal 
dissipation (DII) and the emission of photons as fluorescence (FII).  

 
Figure 11.2: The excited states generated within the pigment matrix of the PSII light harvesting system through 
the absorption of incident photons are energetically equivalent to red photons, even if the absorbed photons 
that generated the excited states were of shorter wavelength (higher energy). Individual excited states are lost 
through photochemistry, thermal dissipation or re-emission as fluorescence.  

The relationships between these processes can be defined by a series of simple equations. As a 

starting point, Equation 11.1 defines LHII as the sum of the absorption cross sections for the three 
processes that are in direct competition with each other for absorbed photons.  

 σLHII = σPII + σDII + σFII Equation 11.1 
 
The probability that an absorbed photon will be lost through a particular process is defined by the 
yield for that process. In turn, the yield for each process can be defined by the rate constants for the 
three competing processes, as shown in Equations 11.2A, B and C. 

 ϕPII =
kPII

kPII+kDII+kFII
 Equation 11.2A 

 

 ϕDII =
kDII

kPII+kDII+kFII
 Equation 11.2B 

 

 ϕFII =
kFII

kPII+kDII+kFII
 Equation 11.2C 

 

Where PII, DII and FII are all dimensionless. The sum of the yields for all three processes must be 
unity (Equation 11.3) since they collectively account for the fate of all absorbed photons. 

 ϕPII + ϕDII + ϕFII = 1 Equation 11.3 
 
Equation 11.4 illustrates an important consequence of the relationships defined by Equations 11.1 
and 11.3. This equation simply states that the absorption cross section of PSII photochemistry is 
equal to the product of the absorption cross section for PSII light harvesting and the probability that 
an absorbed photon will be used to drive PSII photochemistry. 

 σPII = σLHII ∙ ϕPII Equation 11.4 
 
Values for two of the three parameters within Equation 11.4 can be generated directly from STAF 

data. A value for PII can be generated using the equations provided by Kolber, Prášil and Falkowski 

(1998) and a value for PII can be generated from Foc and Fmc using Equation 11.5. 
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 ϕPII =
Fv

Fmc
 Equation 11.5 

 
Where Fv = Fmc – Foc. 

See: The Rho ST curve fit and Glossary of terms 

11.2 PSII photochemical flux (JPII and JVPII) 

As already noted, PSII photochemical flux is dependent on the absorption cross section for PSII 
photochemistry. This can be defined by a single PSII or all PSII complexes suspended within a unit 
volume of medium (m3).  

Equation 11.6 provides a simple expression for the relationship between JPII and JVPII. It should be 
noted that this equation is only valid for a theoretical situation where all RCIIs within the sample are 
in the open state. 

 JVPII = JPII ∙ [PSII] Equation 11.6 

Where [PSII] is the concentration of photochemically active PSII complexes, with units of PSII m-3.  

In the dark-adapted state, the absorption cross section of PSII photochemistry provided by a single 

PSII is defined by PII (units of m2 PSII-1). In the case of all PSII complexes within a m3 of medium, the 
absorption cross section of PSII photochemistry is defined as aPII (units of m2 m-3 = m-1). 

Within an illuminated sample containing multiple PSII complexes, some will be in the open state 
while others are in the closed state. The PSII photochemical flux for a single open PSII complex is 
given by Equation 11.7. 

 JPII = σPII ∙ E Equation 11.7 

Where E is photon irradiance with units of photons m-2 s-1. 

Equation 11.8 generates an average photochemical flux through each PSII (open or closed) within an 
illuminated sample. 

 JPII = σPII′ ∙
Fq′

Fv′
∙ E Equation 11.8 

Where JPII is PSII photochemical flux, Fq' = Fm' – F' and Fv' = Fm' – Fo'. 

Within this equation, PII' denotes the absorption cross section of PSII photochemistry of each open 
PSII complex within the sample and Fq'/Fv' provides a baseline-independent estimate of the 
proportion of PSII complexes within the sample that are in the open state at the point of 
measurement. 

An alternative approach is to use Equation 11.9 to generate a value for LHII. 

 σLHII = σPII ∙
Fmc

Fv
 Equation 11.9 

The value of LHII can then be incorporated within Equation 11.10. 

 JPII = σLHII ∙
Fq′

Fmc′
∙ E Equation 11.10 

 

With this approach, we are using a STAF measurement from a dark-adapted sample to generate a 

value for LHII and then using a STAF measurement from the same sample under illumination to 
generate a value for the efficiency at which harvested photons are used (Fq'/Fmc'). 

The PSII photochemical flux for all PSII complexes within a unit volume of water can be calculated 
using Equation 11.11. 
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 JVPII = aLHII ∙
Fq′

Fmc′
∙ E Equation 11.11 

This approach is similar to Equation 11.10 in the sense that we are using a STAF measurement from a 
dark-adapted sample to quantify PSII light harvesting (in this case, for all PSII complexes within a unit 
volume of water) and the same measurement under illumination to define the average efficiency at 
which harvested photons are used. 

We can define two routes for generating a value for aLHII. The first route (Equation 11.12) 
incorporates the right hand side of Equation 11.9. 

 aLHII = σPII ∙
Fmc

Fv
∙ [PSII] Equation 11.12 

The second route for generating a value for aLHII is illustrated by Equation 11.13 (Oxborough et al. 
2012). 

 aLHII = Ka ∙
Fmc∙Foc

Fv
 Equation 11.13 

Where Ka is an instrument-type specific constant, with units of m-1. 

See: Derivation of Ka   

As an alternative to Equation 11.11, Equation 11.14 can be derived from the relationship defined by 
Equation 11.6 and the right hand side of Equation 11.8. 

 JVPII = σPII′ ∙
Fq′

Fv′
∙ [PSII] ∙ E Equation 11.14 

It follows that Equations 11.11 to 11.14 provide three routes to JVPII: 

• Equation 11.11 combined with Equation 11.12 

• Equation 11.11 combined with Equation 11.13 

• Equation 11.14 

Equations 11.12 and 11.14 include [PSII]. A value for this parameter can be derived using Equation 
11.15 (Oxborough et al. 2012). 

 [PSII] = Ka ∙
Foc

σPII
 Equation 11.15 

Substituting the right hand side of Equation 11.15 for the [PSII] in Equation 11.12 generates 
Equation 11.16, which simplifies to Equation 11.13. 

 aLHII = σPII ∙
Fmc

Fv
∙ Ka ∙

Foc

σPII
 Equation 11.16 

Substituting the right hand side of Equation 11.15 for [PSII] within Equation 11.14 generates 

Equation 11.17. This serves to emphasise the inclusion of both PII and PII' with this approach. 

 JVPII = σPII′ ∙
Fq′

Fv′
∙ Ka ∙

Foc

σPII
∙ E Equation 11.17 

Consequently, we can now define two routes to JVPII: 

• The absorption method: which uses Equation 11.11 

• The sigma method: which uses Equation 11.14 

To select the best method for use in a particular situation, the following points are worth 
considering: 

1. Values of Fo, Fm, F' and Fm' can be measured at higher precision than values of PII and PII'  

2. Values of Fo, Fm and PII can be measured at higher precision than values of F', Fm' and PII' 
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3. Fo, Fm, F' and Fm' are all sensitive to baseline fluorescence 

4. PII and PII' are insensitive to baseline fluorescence 

5. Foc, Fmc, Fc' and Fmc' are insensitive to heterogeneity within the sample 

6. PII and PII' are sensitive to heterogeneity within the sample 

The precision issue raised by Points 1 and 2 is most obvious when photon irradiance is increased to 
levels that saturate photosynthesis. This can decrease the amplitude of Fq' to the point where a 

reliable value of PII' can no longer be generated. 

With the absorption method, baseline fluorescence (Points 3 and 4) increases the value of aLHII and 
decreases the value of Fq'/Fm' (Oxborough et al. 2012). With the sigma method, baseline 
fluorescence increases the value of [PSII] generated by Equation 11.14 in proportion to the increase 
in aLHII.  

Within Equation 11.14, the value of Fq'/Fv' is nominally independent of baseline fluorescence. 
However, if the required value of Fo' is generated using the method provided by Oxborough and 
Baker (1997), baseline fluorescence can decrease the calculated value of Fq'/Fv'. It should be noted 
that the baseline fluorescence-induced decrease in Fq'/Fv' is always lower than the baseline 
fluorescence-induced decrease in Fq'/Fm' and approaches zero with samples that exhibit low levels 
of downregulation.  

An obvious potential form of heterogeneity within a sample (points 5 and 6) is the combining of 

phytoplankton species with differing PII values within the waveband(s) used for the ST 
measurements. Providing the ST pulse is bright enough to ensure that Fm or Fm' is reached for all 
species within a sample, this type of heterogeneity does not generate errors with the absorption 
method (Equation 11.11). This is because the values of Foc, Fmc, Fc' and Fmc' are additive and, as a 
result, both aLHII and Fq'/Fmc' are unaffected. Conversely, this type of heterogeneity can generate an 

error with the sigma method (Equation 11.14) because the PII value generated from adding multiple 
curves together and applying a single Rho fit is unlikely to generate the correct result. Errors 
generated are normally overestimates and, in theory, could reach tens of percent if the spectral 
profiles of phytoplankton species within the sample are very different. Combining phytoplankton 
species within a single sample can also impact on spectral correction.  

See: Photochemical Excitation Profile (PEP) 

11.3 Derivation of Ka 

The current default Ka value for LabSTAF is the same as used with FastOcean and the fluorescence 
values have been scaled to match with FastOcean through a comparative measurements with 
natural samples. It is worth noting that Ka only impacts on the calculated values of JVPII and GOPII 
and that any change in the set value of Ka is immediately applied to existing data. A function has 
been incorporated within RunSTAF to allow for a folder-based update of Ka across files… 

File → Run a folder-based Ka update 

A derivation for Ka was originally provided by Oxborough et al. (2012). Within this manuscript, the 
term KR was used in place of Ka. The only difference between KR and Ka is that the former is only 
applicable to a single fluorometer while the latter can be used with any fluorometers built to the 
same design. This difference is illustrated by Equations 11.18 and 11.19. 

 KR = [PSII] ∙
σPII

Foc
∙ EST Equation 11.18 

 Ka = [PSII] ∙
σPII

Foc
 Equation 11.19 
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The EST term incorporated within Equation 11.18 is required for systems where the primary 
fluorescence data are not scaled to MLED output. Equation 11.19, which omits the EST term, is 
applicable to LabSTAF because fluorescence values are automatically corrected for MLED output. 

The accuracy of Ka derived using Equation 11.19 is dependent on PII and Foc scaling together. As 

already noted, the fluorescence signal and PII have different sensitivities to baseline fluorescence 
and sample heterogeneity. It follows that the most accurate values for Ka from Equation 11.19 are 
likely to come from single species cultures with high values of Fv/Fm. 

Within Equations 11.18 and 11.19, the value of [PSII] is derived using the flash-O2 method described 
by Boatman, Geider and Oxborough (2019). Equation 11.20 provides an alternative for deriving Ka. 
Within this equation, JVPII is derived from direct measurement of O2 release.  

 Ka = JVPII / (
Fmc∙Foc

Fv
∙

Fq′

Fmc′
∙ E) Equation 11.20 

From a purely practical point of view, it is much easier to derive Ka using Equation 11.20 than 11.19. 
One option is to derive the saturated rate of rP from an FLC (calculated as the product of Fq'/Fmc' 
and E) and measure O2 release at the same E using a spectrally matched actinic light source. 
Measuring at saturation is advantageous because although the value of Fq'/Fmc' decreases with E, 
overall accuracy is improved through having the highest rate of O2 evolution. 
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12 Deconstructing rho 

This section has been included to provide a detailed overview of the rho () parameter that is used 
to account for connectivity among PSII complexes. 

See: The Rho ST curve fit  

Equations 12.1 and 12.2 are valid for a dark-adapted sample and assume that all photochemically 
active RCIIs are in the open state at t = 0. Equations 12.3 and 12.4 are valid for a light-adapted 
sample where a proportion of the photochemically active RCIIs within the sample are in the closed 
state. 

 𝐶𝑡 = 𝐶𝑡−1 + 𝐶𝑡=1 ∙ (1 − 𝐶𝑡−1) (1 − 𝐶𝑡−1 ∙ 𝜌)⁄  Equation 12.1 
 
 F𝑡 = Fo + Fv ∙ 𝐶𝑡 ∙ (1 − 𝜌) (1 − 𝐶𝑡 ∙ 𝜌)⁄  Equation 12.2 

 𝐶𝑡 = 𝐶𝑡−1 + 𝐶𝑡=1 ∙ (1 − 𝐶𝑡−1) (1 − 𝐶𝑡−1 ∙ 𝜌′)⁄  Equation 12.3 

 F′𝑡 = F′ + Fq′ ∙ 𝐶𝑡 ∙ (1 − 𝜌′) (1 − 𝐶𝑡 ∙ 𝜌′)⁄  Equation 12.4 

Where t = time since the start of the ST pulse (µs) and Ct is the proportion of centres that were open 
at t = 0 that are closed at t. As a consequence, C is 0 at t = 0 in both the dark-adapted and light-
adapted states, even though a proportion of the photochemically active RCII within the sample are 
in the closed state under ambient light. 

Within a completely homogeneous population of perfectly or imperfectly connected PSII complexes, 

 can be defined as the probability of a photon absorbed by a PSII complex with a closed RCII being 
transferred to a PSII complex with an open RCII and then used to drive PSII photochemistry.  

Figure 12.1 shows ST pulse data from dark-adapted cultured cells of Chlorella vulgaris. Both Rho and 
Dimer fits are also included. 

See: Fitting a dual ST pulse sequence 

 

Figure 12.1: An 
example Saq ST curve 
recorded from 
cultured cells of C. 
vulgaris. The Rho fit 
was made using 
Equations 12.1 and 
12.2. The Dimer fit 
was made using 
Equations 10.7 and 
10.8. The first 76 
points were 
incorporated within 
both fits (t = 1 to t = 
76). 

Although there is a close visual match between the ST data and either fit within Figure 12.1., the Rho 
fit provides a closer overall match than the Dimer fit. In this example, the closer match provided by 
the Rho fit is particularly evident over the first 10 µs or so. Because the value of Fv/Fm is high, 
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RunSTAF has limited the Rho ST fit to the first 76 points to limit the possible impact of electric field-
dependent quenching. Within a theoretical model incorporating zero connectivity among RCII, the 

value of  in Equations 12.1 and 12.2 is zero and the values of PII and PII derived from the fit are 
unchanged as Ct  increases. At the other end of the scale, perfect connectivity among RCII (i.e. all 
RCII within the interrogated volume have equal access to a single light harvesting pigment matrix) 

generates a value of  equal to PII and values of PII and PII that increase with Ct. The curves in 
Figure 12.3 show the original ST curve and Rho fit from Figure 12.1 (A), the fit with zero connectivity 
among RCII (B) and the fit with perfect connectivity among RCII (C). For both B and C, the values of 
Fo and Fm were fixed at the values generated by the Rho ST fit in A. The perfect connectivity in C was 

set by using the value of Fv/Fm from A as a proxy for PII. 

Setting the value of  to zero is equivalent to the 'separate package' or 'puddle' model while setting 

 as PII is equivalent to the 'matrix' or 'lake' model of PSII connectivity (e.g. Butler et al. 1983; 
Kramer et al. 2004). Looking at the three fits within Figure 12.2, it is clear that a good fit to the entire 

ST curve is only achieved by allowing the value of  to assume an intermediate value during the 
iterative fitting process. 

 
Figure 12.2: Rho ST curve fits to the same ST data as presented in Figure 12.1. The fit in A is identical to Figure 

12.1 (Fo, Fm,  and Ct=1 were all allowed to float in Equations 12.1 and 12.2). For the CT fits in B and C, only Ct=1 

was allowed to float. The value of  was fixed as zero or 0.572 (the value of Fv/Fm from A). As with Figure 12.1, 
the x-axes values are t (µs) and the y-axes values are Ft (SU). 

12.1 Estimating  the proportion of PSII complexes in the open state 

From Equations 12.2 and 12.4, it is clear that the relationship between Ft and Ct  in the dark-adapted 

state and F't  and Ct  in the light-adapted state are dependent on the values of  and ' respectively. 

One situation where the impact of ' on the relationship between F't and Ct has practical relevance is 
when using fluorescence to estimate the proportion of the total pool of photochemically active PSII 
complexes in the open state at t = 0, defined here by the term [QA]. A value for [QA] is required when 
using the sigma method to calculate JPII (Equation 11.8) or JVPII (Equation 11.14). Within both 
equations, this value is provided by Fq'/Fv'. It is worth noting that a value for [QA] is not required 
when using the absorption method to calculate JVPII (Equation 11.11). 

Equations 12.5 and 12.6 can be used to calculate a value for [QA] from a dark-adapted sample or a 

sample under actinic illumination, respectively, for any value of  or '. Equation 12.5 can be used to 
quantify [QA] at any point within an ST pulse applied to a dark-adapted sample. Equation 12.6 can be 
used to calculate [QA] at the start of an ST pulse (t = 0) applied to a sample under actinic illumination. 

 [QA] = 1 − (F − Fo) [(1 − 𝜌) ∙ (Fm − Fo) + 𝜌 ∙ (F − Fo)]⁄   Equation 12.5 

 [QA] = 1 − (F′ − Fo′) [(1 − 𝜌′) ∙ (Fm′ − Fo′) + 𝜌′ ∙ (F′ − Fo′)]⁄   Equation 12.6 
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Setting the value of ' in Equation 12.6 to zero makes the right hand side exactly equivalent to 
Fq'/Fv'. In other words, using Fq'/Fv' to estimate [QA] is effectively assuming zero connectivity among 
PSII complexes and is consistent with the separate package or puddle model of connectivity (Baker 
and Oxborough, 2004). The parameter Fq'/Fv' is mathematically equivalent to the widely used 
parameter, qP. At the other end of the connectivity scale, the parameter qL provides an estimate of 
[QA] assuming the matrix or lake model of connectivity (Kramer et al. 2004). Substituting 1 – Fo'/Fm' 

(as a proxy for PII) for ' in Equation 12.6 makes the right hand side equivalent to qL. Equations 
12.7A and 12.7B (Kramer et al. 2004) provide equivalent options for the calculation of qL. 

 qL = 1 − (1 Fo′⁄ − 1 F′⁄ ) (1 Fo′⁄ − 1 Fm′⁄ )⁄  Equation 12.7A 

 qL = qP ∙ Fo′ F′⁄  Equation 12.7B 

The curves in Figure 12.3 were generated using three different values of  within Equation 12.7A. 
The Fq/Fv term on the x-axis is the dark-adapted equivalent of the Fq'/Fv' term within Equations 11.8 
and 11.14. The values of Fo and Fm required to generate these curves were taken from the ST fit in 

Figure 12.1. Setting  as zero has generated a set of qP-based values while setting  as 1 – Fo/Fm (as 

a proxy for PII) has generated a set of qL-based values. These two sets of values provide the 
theoretical extremes for the relationship between Fq/Fv and the value of [QA]. The third curve in 

Figure 12.3 uses the value of  from the ST fit in Figure 12.1 and, by definition, provides the most 
appropriate values of [QA] for the homogeneous, imperfect level of connectivity that is intrinsic to 
the Rho ST model. 

 

Figure 12.3: Data illustrating the relationship between 

Fq/Fm and values of  defined by qP, qL and the ST fit 
value. The ST curve in Figure 12.1 was used as the starting 
point for generating the theoretical values plotted. Data 
points were generated by initially setting Fq equal to Fo 
and then increasing the value in steps of 10% of Fv up to 
Fm. 

12.2 The relationship between  and the yield of PSII photochemistry 

The ST curves in Figure 12.4 are all derived from the single ST curve in Figure 12.1. Each curve within 
Figure 12.4 begins at the stated time within the original curve. The red fits are to the actual data 
points (Saq fits) and the green fits are to the Rho ST fit points (Rho fits). So, for example, the t = 5 µs 
Saq curve in Figure 12.4 is a fit to the Saq ST curve points in Figure 12.1 between t = 5 µs and t = 76 
µs. These points are mapped to between t = 0 and t = 71 µs for the new fit. The t = 5 µs Rho curve in 
Figure 12.4 is a fit to the Rho ST fit points from Figure 12.1 between t = 5 µs and t = 76 µs. As with 
the Saq fit, these points have been mapped to between t = 0 and t = 71 µs for the fit. 

As already noted, the value of C in Equations 12.1 and 12.2 is always zero at t = 0. This means that, 
for all curves in Figure 12.4, the value of C only tracks the closure of RCIIs that were in the open state 
at t = 0.  
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Figure 12.4: ST curve fits 
to subsets of the ST 
curve in Figure 12.1. The 
timestamps on each plot 
defines the points 
cropped from the initial 
ST curve. The red curves 
within the Saq columns 
are fits to the remaining 
raw data points. The 
green curves within the 
Rho column are fits to 
the equivalent section of 
the Rho ST curve fit from 
Figure 12.1. The x-axes 
are all t (µs). The y-axes 
are all Ft (SU). 

The data presented within Figure 12.5 are derived from the Saq and Rho curve fits in Figure 12.4. 

The plots within A show how  changes as the starting point for the fit is increased from t = 0 to t = 

40 µs. Within B, the same   values are plotted against Fq/Fm. The Rho plot shows a linear 
relationship between these values while the Saq plot deviates significantly from a linear relationship. 

The plots within C show how the differences in  derived from the Rho and Saq data impact on the 

derived values of PII.  

 
Figure 12.5: Data derived from the curve fits in Figures 12.1 and 12.2. Saq data and Rho fit data were derived 

for the entire curve with the starting point set between t = 0 and t = 40 µs. A shows  changing with t. B shows 

the relationship between  and Fv'/Fm'. C shows the change in PII, derived from the curve fits.  

Figure 12.6 provides additional examples of   plotted against Fq/Fm from Saq and Rho data fits. 
Example A is derived from a dark-adapted sample. As such, these values are directly comparable 
with those in Figure 12.5 B. Examples B and C within Figure 12.6 are from samples adapted to actinic 
light from the ALED at the values shown. 
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Figure 12.6: Data derived from fits to ST curves using the same fitting process as used for the example in Figure 
12.4. Example A was dark adapted. Samples B and C were adapted to the actinic light levels shown. 

When viewed in isolation, the non-linearity of the Saq plots in Figure 12.6 could perhaps be written 
off as a measurement artefact. However, the FLC-derived data presented within Figure 12.7 provide 

eight examples of a broadly similar relationship between ' and Fq'/Fm' with increasing incident 

photon irradiance. In all eight examples, the decrease in ' with increasing actinic light levels is faster 
than the concurrent decrease in Fq'/Fm'. 

 
Figure 12.7: Screen shot crops of FLC-derived sample data from cultured cells of the species shown within each 
crop. The x-axis is incident photon irradiance with units of µmol photons m-2 s-1. The ST curve shown within 
each crop is the first dark-adapted Saq within each dataset. The plot colours code the same parameters within 

each crop: Red = rP, Green = Fm', Teal = Fq'/Fm' and Yellow = ', as labelled in A. 

The plots of Fm' within the examples in Figure 12.7 track non-photochemical quenching due to 
downregulation. In some examples, most notably B and F, there is very little change in Fm' during the 
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FLC. At the other end of the scale, the plots in C, E and G show very significant quenching of Fm', 
starting at around Ek.  

The homogeneous model defined by Equations 12.1 to 12.4 doesn't distinguish between changes in 

' and Fq'/Fm' driven by the accumulation of closed RCIIs or by downregulation. It follows that the 
model defined by 12.1 to 12.4, while generally providing a convincing fit, can only approximate the 
underlying mechanism. 

12.3 Heterogeneity induced by dimerization of PSII 

As already noted, it seems likely that dimerization of PSII could be responsible for a high proportion 

of the connectivity defined by . 

See: The Dimer ST curve fit 

While the Rho fit assumes a homogeneous, imperfect level of connectivity among PSII complexes, 
the Dimer fit makes three basic assumptions: that the two RCIIs within the dimer are perfectly 
connected, that there is no connectivity among dimers and that all dimers are in the oo state (both 
RCIIs in the open state) at t = 0. Another difference between the Rho and Dimer fits is that while the 
Rho fit does not include a value for [QA] at t = 0 in the light-adapted state, the relative proportions of 
oo, oc and cc dimers at t = 0 are fixed through extrapolation from the dark-adapted fit.  

Because of the additional constraints imposed by the Dimer fit, SE values for the Dimer fit tend to be 
higher than for the Rho fit. One feature that is commonly observed is a higher level of sigmoidicity in 
the early part of a Dimer fit to a dark-adapted sample, compared to either the Rho fit or the actual 
ST data points (e.g., Figure 12.1). Given the constraints incorporated within the Dimer fit, it is not too 
surprising that some deviation is observed between the fit and the actual trace. For example, 

heterogeneity introduced by the combination of PSII and PSII (discussed in the next section) is not 
incorporated within the algorithm.  

Figure 12.8 provides an example of how dimerization changes the relationship between Fq/Fv and . 

 

Figure 12.8: Normalized values of Fq/Fv and  
generated from the dark-adapted ST curve example 
shown in Figure 12.1. Homogeneous shows the linear 

relationship between Fq/Fv and  that is intrinsic to the 

Rho fit. Dimer shows the overall level of  generated as 
[oo] and [oc] change with Fq/Fv. Data have been 
normalized to the t = 0 value for each parameter. 

Because the Dimer fit assumes perfect connectivity within each dimer and zero connectivity among 

dimers, the normalized value of  at any point within Figure 12.8 is provided by Equation 12.8. 

 Normalized 𝜌 =
[oo]

[oo]+[oc]∙0.5 (1−0.5∙𝜌)⁄
 Equation 12.8 

Tracking the change in normalized Dimer  values through the ST curve (from right to left along the 
x-axis), the shape is defined by a first order decay in [oo] accompanied by an increase in [oc] driven 
by closure of one of the two open RCIIs within an [oo] dimer and an decrease in [oc] driven by 
closure of the remaining open RCII. These changes generate the 'S' shape of the Dimer curve and 
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may at least partly explain the Saq relationships between Fq/Fv and  in B of Figure 12.5 and A of 

Figure 12.6 and between Fq'/Fv' and ' in B and C of Figure 12.6. 

12.4 The impact of connectivity on quantification of [QA] 

The data presented within this section show that the value of [QA] derived from fluorescence 
analysis is dependent on the level and type of connectivity assumed to exist among PSII complexes. 
When either of the two extreme levels of connectivity is assumed (the separate package model or 
lake model) the fit to ST data is often poor (see Figure 12.2 for examples). If it is assumed that 

connectivity is homogeneous, and that the fit value of  or ' generated by Equation 12.5 or 12.6 is 
correct, the separate package and lake models are likely to generate values for [QA] that are too high 
or too low respectively. 

The examples presented in Figure 12.7 show a more rapid drop in ' than Fq'/Fm' with increasing 
actinic photon irradiance. As discussed above, this difference strongly implies a heterogeneous 
model of connectivity which can be at least partly explained in terms of dimerization of PSII. Because 

' generally decreases more rapidly than Fq'/Fm', the estimate of [QA] generated using the measured 

' value within Equation 12.6 will approach the separate package value generated by Fq'/Fv' with 
increasing actinic photon irradiance. As a consequence, it seems reasonable to suggest that use of 
Fq'/Fv' within Equations 11.8 and 11.14 is likely to generate an overestimate of [QA] at low actinic 
photon irradiance but reasonably accurate values at Ek and above. In contrast, the lake model values 
of [QA] generated by qL are likely to underestimate values of [QA] through the entire curve with the 
largest errors being generated at around Ek. 
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13 Photochemical Excitation Profile (PEP) 

The main value of PEP data is to facilitate spectral correction of JPII, JVPII and GOPII. The two PEPs 

incorporate values of Fv and PII generated by different combinations of MLED channels. For the Fv 
PEP, the reported values are relative photon yield (relative values of fluorescence generated per 

incident photon). The reported PII PEP values have nominal standard units of nm2 PSII-1. As 

discussed within this section, correction of a spectrally heterogeneous sample using the PII PEP can 
generate large errors. In contrast, correction using the Fv PEP is highly tolerant of spectral 
heterogeneity within the sample. 

13.1 Excitation wavebands for the PEP 

 

The labelling of the eight LabSTAF MLED channels within LabSTAF is as shown 
in this screenshot crop from the RunSTAF home screen. As part of the LabSTAF 
calibration, the emission spectra for all eight MLED channels and the ALED 
channel are recorded from within the sample chamber and stored at 1 nm 
resolution within the scs calibration file for the attached LabSTAF. The two 452 
nm channels are combined into a single waveband. PEP data are processed 
using the wavelength of the measured emission peak for each MLED 
waveband in preference to the channel name values. 

See: LabSTAF calibration 

Figures 13.1 and 13.2 show a completed PEP, cropped from the home screen, with the option to 
show the Spectral Correction Spectra (Show SCS) option inactive and active respectively. 

 

Figure 13.1: A completed PEP recorded 
from cultured cells of Conticribra 
weissflogii with the Show SCS option 
inactive. The 447 nm label in orange text 
defines the central wavelength for this 
waveband as measured during calibration. 

 

Figure 13.2: A completed PEP recorded 
from cultured cells of Conticribra 
weissflogii with the Show SCS option 
active. The extrapolations to virtual points 
(at 380 nm, 440 nm and 660 nm) within 
these plots are discussed within this 
section. 
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13.2 The PEP protocols 

The PEP function generates three reps of seven waveband combinations. With the default settings, 
RunSTAF cycles through all seven waveband combinations at approximately 1 Hz. A user-defined 
number of Seqs are averaged within each rep. The number of Seqs averaged per PEP rep (SeqPEP) is 
defined by Equation 13.1. 

SeqPEP = (Seq / Acq) x (Acq / Saq) x 2  Equation 13.1 

Where (Seq / Acq) and (Acq / Saq) are as set under STAF setup on the home screen. 

There are currently two protocol options for generating a PEP. The default option is run if the two 
452 nm MLED channels are the only ones with a non-zero value under STAF setup. This option (PEP-
bc) is optimised for samples that are dominated by phytoplankton incorporating chlorophylls b or c 
as the main light harvesting pigments.  

The second option (PEP-cy) is run for any other combination of MLED channels (other than just the 
two 452 nm channels) and is primarily intended for samples that are dominated by cyanobacteria 
incorporating phycobilins as the main light harvesting pigments. Table 13.1 shows the LED 
combinations at each step of the PEP within the PEP-bc and PEP-cy protocols.  

Step PEP-bc active channels (nm) PEP-cy active channels (nm) 

1 1st 452 nm + 416 nm 534 nm + 622 nm + 416 nm 

2 1st 452 nm + 2nd 452 nm 534 nm + 622 nm + 2nd 452 nm 

3 1st 452 nm + 473 nm 534 nm + 622 nm + 473 nm 

4 1st 452 nm + 495 nm 534 nm + 622 nm + 495 nm 

5 1st 452 nm + 2nd 452 nm + 534 nm 534 nm + 622 nm 

6 1st 452 nm + 2nd 452 nm + 594 nm 534 nm + 622 nm + 594 nm 

7 1st 452 nm + 2nd 452 nm + 622 nm  622 nm 

Table 13.1: The waveband combinations used for the PEP-bc and PEP-cy functions implemented through 
RunSTAF. The system cycles through all seven steps repeatedly until the programmed level of signal averaging 
has been reached. Typically, each loop through all seven steps takes approximately one second. 

For PEP-bc, the 1st 452 nm channel is as set by the Auto LED function while the 2nd 452 nm channel is 
attenuated to 72% of the optimum value generated during the Auto LED function. The 416 nm and 
473 nm channels are both set as close as possible to the EST output for the 1st 452 nm channel. The 
remaining channels (534 nm, 594 nm and 622 nm) are set to maximum output. 

For PEP-cy, all seven MLED channels used are set to maximum output. 

Gorbunov et al. (2020) recently described a method for physiological and taxonomic analysis of 
phytoplankton communities. Within this study, a mini-FIRe fluorometer was used to provide ST 
pulses from six independent measuring LED wavebands centred at 435, 450, 470, 500, 530 and 590 
nm. Most of the experimental work was focussed on species within four major eukaryotic 
phytoplankton groups: diatoms, dinoflagellates, green algae and haptophytes. All four of these 
groups incorporate chlorophyll b or c as a PSII light harvesting pigment. 

To generate reliable spectral data from ST measurements, three parameters are required from each 

individual measurement: Fo, Fm and PII. The accuracy of Fm and PII is dependent on a high 
proportion of the photochemically active RCIIs in the open state at the start of the ST pulse being 

closed by the end of the pulse. The PII values for diatoms, dinoflagellates, green algae and 
haptophytes tend to be much lower between 500 and 590 nm than they are between 435 and 470 

nm. For example, PII values at 590 nm are typically around 25% of values at 435 and 450 nm. It 
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follows that you need to deliver approximately four times as many photons from measuring LEDs at 
590 nm, compared to 450 nm, in order to close the same proportion of RCIIs within the same 
timeframe.  

Within the study conducted by Gorbunov et al. (2020) the required level of saturation at 530 and 
590 nm was achieved through a combination of higher photon irradiances and longer ST pulses than 
were used with the shorter wavebands (150 µs for the 530 and 590 nm wavebands, compared with 
80 µs for the 435 and 450 nm wavebands). With the PEP function incorporated within RunSTAF, the 
ST pulse duration is the same for all wavebands and the required level of saturation is reached by 
combining wavebands (Table 13.1). 

Table 13.2 provides a comparison of the maximum measuring LED output for the seven wavebands 
incorporated within LabSTAF and the nearest equivalent wavebands used within Gorbunov et al. 
(2020). 

Waveband 

central  

(nm) 

Maximum photon irradiance (typical) 
µmol photons m-2 s-1 
[photons nm-2 (100 µs)-1] 

Gorbunov et al. (2020) 
µmol photons m-2 s-1 

416 13,851  [0.834] 

20,000 – 25,000 for each waveband 
between 435 and 505 nm 

452 x 2 34,047  [2.051] 

473 16,574  [0.998] 

495 10,142  [0.611] 

534 9267  [0.558] • 40,000 – 60,000 for the 530 and 590 nm 
wavebands 594 2500  [0.151] 

622 8206 [0.494] NA 

Table 13.2: The maximum photon irradiance provided by the measuring LED wavebands incorporated within 
LabSTAF and those used by Gorbunov et al. (2020). The 452 nm photon irradiance is the sum of both channels. 

A central feature of the PEP method is determination of waveband-specific photon yield of Fv, and 

PII values by combining different wavebands to reach saturation. For the PEP-bc option, the 452 nm 

waveband is incorporated within all seven waveband combinations. Because PII is high at 452 nm 
for the four major eukaryotic phytoplankton groups, its incorporation provides saturation with all 
waveband combinations within PEP-bc. Step 2 of PEP-bc in Table 13.1 provides direct 452 nm-

specific values of the photon yield of Fv, and PII. Values of these parameters for the other 
wavebands are then calculated as the difference between the 452 nm-specific values and the values 
measured using the waveband combinations listed in the PEP-bc column of Table 12.1. 

Automated optimisation of MLED intensity is incorporated within the PEP procedure. With PEP-cy, 
achieving saturation is more challenging that with PEP-bc and often requires increasing the duration 
of the ST pulse from the default of 100 µs.  

13.3 Checking PEP saturation 

Figure 13.3 provides two example PEP plots from a freshwater chlorophyte (Chlorella vulgaris) and a 
freshwater cyanobacterium (Anabaena sp.). Although there is a reasonable match between the Fv 

and PII traces within each example, there are also some highly reproducible differences. 

Also included within this figure are the ST traces generated by the PEP protocol. These data are not 
shown within RunSTAF but can be accessed through the Clipboard →PEP data option on the 
RunSTAF menu. The ST traces all show good saturation for all waveband combinations. For 
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Anabaena sp., the ST pulse duration has been increased from the default of 100 µs to 200 µs to 
ensure good saturation. 

  

Figure 13.3: Sample PEPs optimised for chlorophylls b and c (PEP-bc) or for phycobilins (PEP-cy). The waveband 
evaluated by each ST pulse is shown in bold. 

13.4 The impact of heterogeneity on PEP data 

Figure 13.4 shows five PEP screen crops from each of three different phytoplankton cultures. The Fv 

and PII values are both plotted on a scale that goes from zero to one. For spectra with all values 
greater than zero, points are normalized to the highest value. For plots with one or more negative 
values, the entire range is rescaled to between zero and one.  

The PEPs in the first set (Figure 13.4, A1 – A5) were recorded from samples of C. vulgaris (CCAP 

211/11B), using the PEP-bc protocol. In all cases, all points shown within the Fv and PII PEPs are 

greater than zero and the highest values are at the 452 nm waveband. Although the Fv and PII PEPs 

are closely matched overall, it is worth noting that the normalised PII values are consistently lower 
than normalized values for Fv at 416 nm and 622 nm.  

For a completely homogeneous population of PSIIs, Fv:PII should be constant across all wavebands. 

However, there is scope for Fv and PII to diverge where some form of PSII heterogeneity exists 
within the sample. One well documented type of PSII heterogeneity within the four major eukaryotic 

phytoplankton groups is the division between PSII and PSII (Andrée, Weis and Krieger, 1998; 

Black, Brearley and Horton, 1986; Guenther and Melis, 1990; de Marchin et al. 2014). PSII are less 

numerous than PSII, have a much smaller light harvesting complex and a higher ratio of chlorophyll 
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a to chlorophyll b. In combination, these characteristics have the potential to account for the 

divergence between Fv and PII at the 416 nm and 622 nm wavebands. Within the proposed model, 

the reported Fv at each waveband is the sum of the signals from PSII and PSII. In contrast, PII is 

much lower for PSII than PSII, because the PSII light harvesting complex is much smaller than the 

PSII light harvesting complex. As a consequence, the measured values of PII for PSII plus PSII are 

lower than for PSII alone. Because PSII have a higher chlorophyll a to chlorophyll b ratio than 

PSII, the PSII-dependent decrease in PII is more evident at the 416 nm and 622 nm wavebands 
because absorption by chlorophyll a relative to chlorophyll b is highest at these points.  

 
Figure 13.4: Sets of five PEPs from three phytoplankton species. A1 – A5 are from Chlorella vulgaris. B1 – B5 
are from Anabaena sp. C1 – C5 are from Alexandrium catenella. 

The PEPs in the second set (Figure 13.4, B1 – B5) were recorded from samples of Anabaena sp. 

(CCAP 1403/13A), using PEP-cy. As with the C. vulgaris set, all points within the Fv and PII PEPs are 

greater than zero. The Fv and PII PEPs are both normalized to the 622 nm waveband.  
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Within all of the Anabaena sp. plots, the normalized values of Fv are consistently higher than the 

normalized values of PII values at the 416 nm, 452 nm, 534 nm and 594 nm wavebands. The PSII 
light harvesting system within Anabaena sp. comprises a relatively small compliment of chlorophylls 
a within each PSII core complex plus phycocyanin and allophycocyanin within phycobilisomes. It 

follows that the heterogeneity causing divergence between Fv and PII values at 416 nm and 452 nm 
may simply be between PSII complexes that are energetically connected to phycobilisomes and PSII 
complexes that are not. Within this model the phycobilisome-connected PSII complexes would 

generate much higher PII and Fv in the red (594 nm and 622 nm) than in the blue (416 nm and 452 

nm). Conversely, PII and Fv would both be higher in the blue than in the red for disconnected PSII 
complexes. Because Fv is additive, the disconnected PSII complexes increase the overall signal within 
the blue but do not contribute significantly within the red. In contrast, the phycobilisome-connected 

and disconnected PSII complexes would have very similar PII values within the blue while PII values 
within the red would be almost entirely attributable to the phycobilisome-connected PSII complexes. 

As a consequence, the PII PEP is likely to be representative of the phycobilisome-connected PSII 
complexes while the Fv PEP provides a more accurate assessment of the complete PSII population 
within the sample. 

The PEPs in the third set (Figure 12.4, C1 – C5) were recorded from samples of a marine 
dinoflagellate, Alexandrium catenella (CCAP 1119/17), using the PEP-bc protocol. Of the three 

examples, this one shows the greatest divergence between the normalized Fv and PII values. As 

with C. vulgaris, the highest values for Fv and PII are at the 452 nm waveband and both PEPs are 

normalised to this point. As with both C. vulgaris and Anabaena sp., the normalized PII value is 
lower than Fv at the 416 nm waveband. The PEP-bc protocol was used for this set because A. 
catenella incorporates chlorophyll c as a PSII light harvesting pigment. Because the PEP-bc protocol 
was used, any PSII complexes within the sample that rely on longer wavelength light harvesting 
pigments, such as phycocyanin and allophycocyanin, are unlikely to have been saturated. This could 

be an issue here because the greatest divergence between Fv and PII occurs at the three longest 
wavebands. This divergence at the three longest wavebands may indicate that the samples used 
were contaminated with cryptophytes and/or cyanobacteria or that the cells of A. catenella 
incorporate cyanobacteria cells as symbionts (e.g., Nakayama et al. 2019). 

13.5 Scaling PEP data 

The data presented within Figure 13.5 are derived from the same datasets as presented in Figure 

13.4. The left columns show the standard Fv PEP and PII PEP values. The values in the right columns 

are normalized to the ALED Fv and PII values. 

Normalizing Fv PEP data to the ALED Fv values neutralizes the impact of differences in cell density 

between reps. Although the expectation is for PII to be independent of cell density, normalizing to 

ALED values of PII has brought rep values closer together for all three species.  

Figure 13.6 shows a representative single PEP plus dark ST pulse combination from each of ten 
species of phytoplankton, including the three species represented in Figures 13.4 and 13.5. Multiple 
reps (minimum of three) from each culture exhibited the same relationship between the Fv PEP and 

PII PEP as shown within these examples.  

Examples A to E within Figure 13.6 are all diatoms. Both the Fv and PII PEPs for A, B and C are very 
similar to each other in shape and significantly different from the non-diatom examples provided by 

F to J. The PII PEPs for D and E show a slightly different shape to A, B and C in that the 495 nm 
channel is relatively high and the 534 nm channel is relatively low. The 416 nm channel is also 

noticeably lower for E. Within D and E, there are clearer gaps between the Fv and PII PEPs than are 
evident within A, B and C. This may indicate the presence of one or more additional phytoplankton 
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species within these cultures. It is noticeable that the relative shapes of the Fv and PII PEPs in the 
example for the large diatom, C. granii (E) is similar to the dinoflagellate, A. catenella (J). 

 

 

Figure 13.5: Data derived from the PEPs shown in Figure 13.4. The leftmost column shows Fv PEP values on the 

SU scale. The next column from the left shows PII PEP values with units of nm2 PSII-1. The two remaining 

columns show the Fv PEP and PII PEP values normalized to the ALED Fv and PII values.  

Most of the PII PEP data within Figure 13.6 are consistent with the spectra presented by Gorbunov 
et al. (2020). The two notable differences are with C. granii and A. catenella. In both cases, it seems 
reasonable to suggest that the cultures may be contaminated by at least one additional species with 
a significantly different spectral profile. 

Although the examples presented within Figures 13.6 provide a very limited dataset, it seems 

reasonable to conclude that combining Fv PEP data and PII PEP data is likely to add significantly to 
the information provided by either data set alone.  



Page 81 of 116 
 

 
Figure 13.6: Representative PEP plus ST pulse for each of ten phytoplankton species. All samples are from 
cultures grown at 15 °C on a 16h/8h day/night cycle. Incident photon irradiance (white light) was 50 µmol 
photons m-2 s-1 for A to E and I, 120 µmol photons m-2 s-1 for F and G and 80 µmol photons m-2 s-1 for H and J. 

13.6 Using PEP data to apply a Spectral Profile Correction (SPC) 

The target range for application of a SPC is between 380 nm and 660 nm which requires 
extrapolation beyond the spectral range of the PEP at each end. Figure 13.7 shows the 
extrapolations made to generate the SPCs from PEP data for the ten species shown in Figure 13.6.  

To complete the PEP spectral range, the following extrapolations are implemented: 

1. A straight line is applied between the 416 nm waveband point and zero at 380 nm 

2. The slope of the line between the 473 nm waveband point and the 452 nm waveband point 
is extrapolated to 440 nm (the absorption peak of chlorophyll a within this region) 

3. A straight line connection is drawn between the derived 440 nm point and the measured 
416 nm point 

4. The slope of the line between the 594 nm waveband point and the 622 nm waveband point 
is used to extrapolate to 660 nm 
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Extrapolation 1 has minimal impact on the SPC, simply because the actinic light emits very little 
between 380 and 416 nm. The other three extrapolations do have a small impact on the SPC. 

 

Figure 13.7: Representative 
PEP data plots with Spectral 
Correction Spectra (SCS) 
activated. All examples are 
the same as presented within 
Figure 13.6. 

These extrapolations are based on comparisons made between PEP data and high resolution 
Fluorescence Excitation Spectra (FES). Figure 13.8 provides some comparisons between FES data 
generated from four phytoplankton species during the study by Silsbe et al. (2015) and RunSTAF-
generated SPC data. The paired species within each plot have been selected to provide the best 
available match of light harvesting pigments. In examples A, B and C, the main PSII light harvesting 
pigments are chlorophyll a and chlorophyll c. In example D, both species incorporate chlorophyll a 
and chlorophyll b.  

In assessing the differences between the spectra within each plot, it is important to note that while 
the Fv data used to generate the SPC plot are exclusively from functional PSII complexes, the Fm data 
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used to generate the FES plots potentially include fluorescence from photoinactivated PSII and other 
sources. One clear objective for future work is to generate FES and SPC data from the same samples. 

 

Figure 13.8: The 
Fluorescence Excitation 
Spectra (FES) traces are 
from Silsbe et al. (2015). The 
SPC traces were extracted 
from recent LabSTAF data. 

 

It is possible that implementation of the SPC will undergo modifications in future, as more data 
become available. The logging of primary STAF data within RunSTAF files makes it possible to rapidly 
apply updates of this kind across large datasets. 

13.7 Derivation of PEP values 

As already noted, the values of Fv and PII for each waveband within each PEP are calculated 
through simple subtraction. For the PEP-bc values, Step 2 (the 452 nm only waveband) provides the 
subtracted value for the other six wavebands. An intensity correction is applied to the subtracted 
452 nm value for Steps 1, 3 and 4 (the 416 nm, 473 and 495 nm wavebands, respectively) to account 
for the use of only one of the two 452 nm channels. For the PEP-cy values, Step 5 (the 534 nm plus 
622 nm wavebands) provide the subtracted value for Steps 1, 2, 3, 4 and 6 (wavebands 416 nm, 452 
nm, 473 nm, 495 nm and 594 nm, respectively). Step 7 then provides the subtracted value for the 
534 waveband. 

As an alternative to the simple subtraction of Fv and PII values derived from the ST curve fits, it is 
feasible to subtract one curve from another and apply a fit to the difference. The data in Figure 13.9 
provide an example of this approach.  

Plots A, B and C of Figure 13.9 show the three ST trace reps for the 452 nm, 594 nm and 622 nm 
waveband evaluations for the two cultures. Note that these are the primary data incorporated 
within the Clipboard output and are not normalized to EST values. In all cases, the noise level is low 

enough and the degree of saturation high enough to be confident of the PII, Fo and Fm values 
derived from the fits. 

The traces in the D plots of Figure 13.9 are derived from the average of the three reps in each of A, B 
and C and are all normalized to the appropriate EST values. The 452 nm trace is simply the average of 
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the three reps in A normalized to EST values from the 452A plus 452B channels. The 594 nm and 622 
nm traces are the average of the traces in B or C respectively minus the average of A, normalized to 
EST values for the 594 or 622 channel respectively. 

 

 
Figure 13.9: PEP data from cultured cells of C. vulgaris (left) and A. catenella (right) acquired using PEP-bc. The 
ST traces within A, B and C for each culture are the three reps used for evaluation of the 452 nm, 594 nm and 
622 nm wavebands. The ST traces within D for each culture show average traces for A (452 nm), B minus A 
(594 nm) and C minus A (622 nm) normalized to the appropriate EST value. 

For C. vulgaris, the highest fluorescence values within the normalized 594 nm and 622 nm traces are 
at around 30 µs. In both cases, these values are approximately 8% higher than the end point of each 
trace. If these high point values were taken as Fm, the values of Fv would be assessed as 10 to 20% 
higher than the values calculated in the normal way. In contrast to the normalized 594 nm and 622 
nm traces within D of C. vulgaris, the equivalent traces for A. catenella show a similar 'shape' to the 
452 nm trace. 

The simplest interpretation of the 594 nm and 622 nm traces within plots D for both cultures is that 
they quantify the increase in fluorescence induced by addition of the 594 or 622 channel 
respectively to the 452A and 452B channels. In the case of C. vulgaris, this is almost certainly not the 
case. A more likely explanation is that the rise to the 30 µs peak seen in both traces is due to 
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connectivity between PSII complexes such that addition of the 594 nm or 622 nm waveband 
increases the rate at which the 452 nm waveband closes RCII during the early part of the curve. 

In contrast to the example of C. vulgaris, where the Fv and PII PEPs are closely matched through the 

entire range, the Fv and PII PEPs from A. catenella diverge widely within the spectral range that 
incorporates the 594 nm and 622 nm traces. Earlier in this section, this divergence was attributed to 
the presence of two populations of PSII complexes within the sample that are spectrally very 
different from each other: the assumption being that one population is intrinsic to A. catenella and 
the other to a separate symbiotic or contaminating species. This explanation is supported by the 
similarity of the shape of all three ST traces in the D plot for A. catenella which is most easily 
understood in the context of a lack of connectivity between one population of PSII complexes 
dominating absorption at 452 nm and the other population of PSII complexes dominating absorption 
at 594 nm and 622 nm. 

13.8 Which PEP should be used for SPC? 

From the data presented within this section, it seems reasonable to concluded that the Fv PEP 

provides a more reliable spectral correction than the PII PEP. A potential limitation to the accuracy 
of the Fv PEP is that the value for each waveband is dependent on the Fm asymptote being 

determined correctly by the fitting process. For samples with closely matched Fv and PII PEPs, visual 
inspection of the ST data is likely to provide a reliable check on the asymptote being reached. For 

samples exhibiting significant differences between the Fv and PII PEPs, it is conceivable that a small 

error could be introduced by one sub population of PSII complexes with high PII at a specific 

combination of wavebands masking the presence of a second sub population with a low PII at the 
same combination of wavebands. 

The main value of extracting both Fv and PII PEPs is for qualitative assessment of heterogeneity 
within a sample. In addition to providing a basic assessment of community structure within natural 

samples and contamination of cultures, comparison of Fv and PII PEPs also have potential for 
monitoring dynamic changes in community structure, as might occur during bloom development. 

14 Package Effect Correction (PEC) 

When using the absorption method to derive values for JVPII, measurement accuracy is highly 
dependent on there being a consistent ratio between photons used to drive photochemistry and 
photons emitted as fluorescence (i.e., the ratio between JVPII and JVFII must be consistent). The 
package effect can have a very significant impact on this ratio. 

The package effect is largely a consequence of the high concentration of chlorophyll a and other 
light-absorbing pigments within phytoplankton cells. To put this in context, while the concentration 
of chlorophyll a within the open ocean is often below 0.1 mg m−3, the concentration within 
phytoplankton cells is approximately a million times higher than this, at 0.1 kg m−3 (calculated from 
data within Montagnes et al., 1994). It follows that while sea water with phytoplankton cells 
suspended within it can be considered optically thin, the localized volume within each 
phytoplankton cell is optically very thick (see Boatman, Geider and Oxborough, 2019 and references 
therein). 

With LabSTAF, fluorescence emission is normally defined by a 685 nm bandpass filter in front of the 
PMT. Because this is very close to the emission peak from PSII within phytoplankton cells (around 
683 nm) the proportion of the fluorescence signal coming from PSII is maximised. On the downside, 
the red absorption peak of chlorophyll a is Stokes shifted by only 2-3 nm from the emission peak 
and, consequently, reabsorption of fluorescence is also maximised. The probability of reabsorption is 
dependent on the size and optical characteristics of the cell plus the concentration of chlorophyll 
within the cell. At one end of the scale, it is likely that reabsorption within a small cell with a simple 
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cell wall will be low (low package effect) while reabsorption within, for example, a large haptophyte 
surrounded by coccoliths will be much higher (high package effect). The images below illustrate this 
phenomenon. 

 

With a simple small cell, a high proportion of 
the photons emitted as fluorescence make it 
out of the cell. Consequently, the measured 
ratio of JVFII to JVPII is at the higher end of 
possible values. 

 

With increasing size and changes in optical 
characteristics, the proportion of photons 
emitted as fluorescence that make it out of 
the cell decreases due to reabsorption. 
Consequently, the measured ratio of JVFII to 
JVPII becomes lower. 

 

Fluorescence emission is much higher at 682 
nm than at 730 nm. However, reabsorption of 
fluorescence at 682 nm, relative to 730 nm, is 
orders of magnitude higher still. It follows that 
the 730 nm : 682 nm emission ratio has the 
potential to provide a correction for the 
package effect. 

In addition to the 685 nm bandpass filter that is normally used to define fluorescence emission, 
LabSTAF incorporates a 730 nm bandpass filter. Both filters are ±10 nm Full Width-Half Max FWHM. 
A linear actuator is used to switch between these two filters as the DWC is run. Three reps of 685 
and 730 nm measurements are made and stored within the RunSTAF data file. These primary data 
are available through Clipboard → DWC data. 

The number of sequences averaged within each rep (nSeqDWC) is defined by Equation 14.1. 

nSeqDWC = (Seq / Acq) x (Acq / Saq) x 2  Equation 14.1 

Where Seq / Acq and Acq / Saq are as set under STAF setup on the home screen. The Seq interval 
set under STAF setup is applied when the DWC is run. The 2nd pulse is always set to zero length 
while a DWC is running. 
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If the Apply DWC option is active, the Value is applied and values of JVPII and 
GOPII are immediately updated. 

For reference, the transmission spectra for the 685 nm and 730 nm bandpass filters incorporated 
within each LabSTAF unit are provided on the Spectra tab within the Excel calibration workbook. This 
workbook can be found on the Surface Go2 computer provided as part of the LabSTAF delivery pack.  
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15 Delivery pack 

In addition to the LabSTAF unit and the contents of Table 15.1, the delivery pack includes 3 m of 3 
mm ID silicon tubing and mains cables. 

# CTL reference Item Quantity 

1 2408-099-AS 24 V DC Power supply for LabSTAF 1 

2 113607 USB-A to LabSTAF cable 1 

3 105244 USB-C to USB-A adapter 1 

4 2408-024-AS Peristaltic pump unit 1 

5 2408-169-AS Solenoid unit 1 

6 113604 Solenoid unit to LabSTAF cable 1 

7 2408-160-AS Flow-through stirrer unit 1 

8 2408-070-AS Flow-through unit 1 

9 2408-157-MD Calibration plug 1 

10 2408-158-MD Sample chamber lid 1 

11 925791278 Connectors: 7 – 11 mm + 11 – 16 mm 2 

12 117250 8 mm ID silicon tubing 2 x 80 mm 

13 118054 4 mm ID tubing 80 mm 

14 114126 O-rings (spare) 4 

15 113639 7 mL sachet of silicon grease 1 

16 118842 Fischer 102 blanking plug (spare) 2 

17 105243 Surface Go 2 Intel Core M3 and power supply  1 

18 12052 Surface Go Keyboard 1 

Table 15.1: Items stored within the LabSTAF accessory case. 

The images on the next page show the contents of the accessory case. The Surface Go 2 and Surface 
Go Keyboard (#17 and #18) are absent in the top image, to show the underlying parts, and in place in 
the lower image. 
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16 LabSTAF hardware setup 

16.1 Plumbing the flow-through unit, peristaltic pump and solenoid unit 

 

The LabSTAF flow-through unit with In and Out ports 
labelled. Make sure the connectors are screwed in 
tightly before using. 

If the Auto FLC mode is being used without the 
solenoid unit, the In on the flow-through unit can be 
connected directly to the Out connector on the 
peristaltic pump unit. Otherwise, the Out on the flow-
through unit should be connected to the In on the 
peristaltic pump unit. 

 

 

Detail of the peristaltic pump head with In and Out ports 
labelled. 

When running the system in Auto FLC mode, the plumbing shown below must be adhered to.  

 

This image shows a valve of the type used within the LabSTAF solenoid 
unit. The single port on the left is the Common port (COM). This is the 
output for each of the three valves (A, B and C) when the unit is plumbed 
in correctly. The upper port on the right is Normally Open (NO) and the 
lower port is Normally Closed (NC). Table 14.1 shows the status of each 
valve for each Auto FLC function. 

The switch from NO to NC requires 24 V delivered from the LabSTAF unit 
through the SOLENOID VALVE UNIT connector located on the top panel. 
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The images above show the solenoid unit as 
supplied from the factory. On the left, the unit 
is viewed from above to show the labelling of 
Solenoids A, B and C. On the right, the unit is 
oriented to show Solenoids A and C from the 
side. Tube 1 connects the common from 
Solenoid C to the Normally Closed (NC) on 
Solenoid B. Tube 2 connects the common from 
Solenoid B to the NC of Solenoid A. Both tubes 
are 60 mm lengths of 3 mm ID silicon. 

The image left shows the inlets and outlets for 
the standard configuration, as detailed within 
the table below.  

Solenoid connection Connects to… 

Solenoid A, COM In connector on the LabSTAF flow through unit 

Solenoid A, NO No connection (air input) 

Solenoid A, NC Solenoid B, COM (sample exchange and/or cleaning) 

Solenoid B, COM Solenoid A, NC 

Solenoid B, NO Sample exchange reservoir 

Solenoid B, NC  Solenoid C, COM (cleaning) 

Solenoid C, COM Solenoid B, NC 

Solenoid C, NO Cleaning fluid (first step of cleaning cycle) 

Solenoid C, NC Rinsing fluid (second step of cleaning cycle) 
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17 LabSTAF calibration 

The calibration values used to process data are always saved within the RunSTAF file and are easily 
accessible. This approach maximises the options for reprocessing of primary data. 

17.1 Calibration data stored within the LabSTAF unit 

To view the calibration values, select… 

Settings → Factory → View calibration data 

From the menu bar. The screenshot crops within Figure 18.1 provide an example of the calibration 
values automatically loaded from an attached LabSTAF unit.  

 
Figure 17.1: Screenshot crops from the RunSTAF calibration screen with a LabSTAF unit attached. The Show 
plots and Hide plots buttons (not shown here but located at bottom right of the full calibration screen) switch 
between the two screens. The Save changes button included within the upper screenshot is only shown after 
one or more values have been changed.  
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17.2 The spectral calibration spectra (scs) data file 

In addition to the calibration data loaded from the attached LabSTAF, the spectral output of all seven 
MLED wavebands and the actinic LED within the LabSTAF unit are loaded from a spectral correction 
spectra (scs) file installed on the controlling computer. The scs filename is matched to a specific 
LabSTAF unit through the serial number without the dashes. For example, the LabSTAF unit attached 
in the above screenshots has the serial number 20-0325-001. The matching scs file is 200325001.scs. 
This file must be located within this folder: 

Documents → LabSTAF → Calibration files 

The Calibration files folder is created by RunSTAF. The scs files for multiple LabSTAF units can be 
stored within this folder. RunSTAF will select the correct file based on the filename (matched to the 
serial number of the attached LabSTAF unit). 

17.3 Create a local backup of the calibration data stored within LabSTAF 

All calibration data for all LabSTAF units are stored by CTL and are available on request. A local 
backup of the calibration data stored within an attached LabSTAF unit can be made by selecting… 

Settings → Factory → Save calibration data 

From the menu bar. This generates a file within this folder: 

Documents → LabSTAF → Calibration files 

The filename for the calibration backup is matched to a specific LabSTAF unit through the serial 
number without the dashes. The file extension is stc. For example, the LabSTAF unit attached in the 
above screenshots has the serial number 20-0325-001. The matching stc file is 200325001.stc. This 
file can be used to overwrite any changes made to the calibration data. The file can be recovered by 
first selecting… 

Settings → Factory → View calibration data 

end then selecting… 

Settings → Factory → Load calibration data 

The Save changes button must be pressed to update the changes within the attached LabSTAF unit. 

17.4 Post-processing with the scs data file 

The scs data are used to apply a spectral correction to RunSTAF data. This correction is required to 
generate values for JPII, JVPII and GOPII. If the scs file is absent during data acquisition, values for 
these parameters will not be generated in real time. However, it is possible to post-process the data 
to apply the spectral correction and generate values for JPII, JVPII and GOPII.  

To apply post-processing, the required scs file must be copied to the Calibration files folder. Now, 
when RunSTAF data files are opened, the scs file will be used to automatically apply spectral 
correction and generate values for JPII, JVPII and GOPII. When the updated data file is saved, the scs 
data are incorporated within it. This means it can be opened on another computer without the scs 
data file being present. 

17.5 On-site calibration of sample chamber temperature 

The temperature within the sample chamber is monitored by an internal thermocouple. If there is a 
large difference between the ambient temperature and the temperature within the sample 
chamber, the reported value may be significantly higher than the actual sample chamber 
temperature. The steps below can be used to generate a more accurate value.  
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In most cases, a single point calibration can be run to generate a new TC slope. To activate the 
calibration mode, start RunSTAF and select… 

Settings → Acquisition mode → Manual 

…from the menu bar. Then select…   

Settings → Factory → Manual calibration modes → Sample TC 

 

This will activate an ADC field 
next to the Sample temperature, 
as shown here. 

The formula for using the ADC value to set the reported temperature is provided by Equation 18.1. 

 Sample °C = ADC x TC slope + TC offset Equation 18.1 

In this example, the actual temperature within the sample chamber was 22.6 °C. The reported 
temperature (Sample) is 23.4 °C and the reported ADC value is 616.  

To change the calibration values for the sample thermocouple, select… 

Settings → Factory → View calibration data 

 

The current TC slope TC offset is 0.038. Dividing the actual 
temperature by the reported ADC value of 616 gives a new TC 
slope of 0.0367. 

 

Changing the TC slope value activates the Save changes 
button. Pressing this button saves the changes to the attached 
LabSTAF unit. 

 

The reported value is now 
correct. 

17.6 Updating calibration values across existing data files 

This function has been incorporated within RunSTAF to allow for the updating of calibration data 
across data files when one or more incorrect values have been found. Although the most likely 
mismatch is the TC slope used to define the recorded sample temperature, all calibration values are 
assessed for changes and any required re-calculation of data is applied. 

The function can be accessed through… 

Settings → Factory → Update across files 
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18 Technical information 

Basic specifications of the LabSTAF unit 

Power requirements Between 140 and 400 mA at 24 V (3.4 and 9.7 W) 

Dimensions 235 x 320 x 420 mm 

Mass (approximate) 8.1 kg 

Sample chamber 20 mL maximum sample volume 

Excitation wavebands Central wavelengths at: 416, 452 x 2, 473, 495, 534, 594, 622 nm 

Actinic light source Collimated output from 10 to 2000 µmol photons m-2 s-1 

Detection limit 
(approximate) 

Can resolve Fv with an amplitude equivalent to the fluorescence signal 
generated under 452 nm excitation by 0.001 mg m-3 of chlorophyll 

IP rating IP64 (protected from water spray from any direction) 

Table 18.1: Basic specification of the production LabSTAF unit (2408-040-AS).  

18.1 The measurement LEDs and PMT 

The measurement LEDs (MLEDs) provide the ST pulses. There are eight channels with five LEDs in 
each, distributed between two four channel arrays. Each array is connected to a four channel drive 
circuit which allows the drive current to be set independently for each channel.  

The maximum drive current rating for the LEDs used within LabSTAF is between 700 mA (594 nm and 
624 nm) and 1000 mA (all other wavebands). The maximum drive current settable through RunSTAF 
is 460 mA. This limitation is imposed to ensure that the intensity of each ST pulse remains constant 
for the entire duration. 

 

Figure 18.1: Two-stage MLED 
optics provide homogeneous 
illumination throughout an 
interrogated volume of 
approximately 0.5 mL.  

The collimated MLED light from each array is passed through a cutoff filter (625 nm shortpass for 
MLED A, 650 nm shortpass for MLED B) before being directed through the interrogated volume. The 
fluorescence emission from the interrogated volume is Lambertian (uniformly spherically radiative). 
The first stage of the MLED and PMT optics collects a proportion of the emitted photons which are 
directed through a bandpass filter, centred at 685 nm or 730 nm, and a 630 nm longpass filter 
before being focussed onto the active area of the PMT. 
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Figure 18.2: Transmission spectra from the bandpass filters in front of the PMT (left) and emission spectra 
from the MLEDs (right). These spectra are recorded for all production units and incorporated within the 
calibration certificate at 0.1 nm resolution. 

18.2 The actinic light source 

 

Figure 18.3: Actinic light is delivered 
to the entire sample from a single 
Actinic LED (ALED) via a collimating 
Compound Parabolic Collector 
(CPC). The base of the sample 
chamber is a 3 mm BG38 glass filter, 
sandwiched between two 0.5 mm 
layers of BK7 glass. A multi-layer 
coating on the BK7 surface facing 
the ALED provides a 635 nm 
shortpass filter. 

The output range of 10 to 2000 µmol photons m-2 s-1 is provided by a single LED using a 12-bit 
constant current DC drive circuit. At very low current, where output is temperature sensitive, a 
photodiode integrated within the CPC monitors the actual output and adjusts the drive current to 
get as close as possible to the requested value. The actual value is logged. 
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Figure 18.4: Emission 
spectrum recorded from 
an ALED. The ALED 
spectrum is recorded for 
each production unit and 
incorporated within the 
calibration certificate at 
0.1 nm resolution. 

18.3 Sample temperature control 

The sample chamber thermal block is insulated from the main internal volume. However, this 
thermal block has a much better thermal connection to the internal optics than the internal 
electronics. Consequently, running the sample at very low temperature can result in the internal 
optics being cooled to the point where there is a significant temperature differential between the 
optics and the internal electronics. A humidity sensor has been incorporated within the main 
internal volume (the space occupied by the internal electronics) to check for the possibility of 
condensation forming on the optics. Table 18.2 provides a guide to the dew point on a mirror 
surface at different System RH values when the System temperature (inside the unit) is 32 °C.  

Relative Humidity (RH) 
at 32 °C Dew point 

10% -3.4 °C 

12% -1.0 °C 

14% 1.1 °C 

18% 4.7 °C 

24% 8.9 °C 

30% 12.2 °C 

36% 15.0 °C 

42% 17.5 °C 

Table 18.2: Dew point values at different System RH values 
when the System temperature is 32 °C. 
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18.4 PMT temperature coefficient 

 
Figure 18.5: Continuous recording of the system temperature allows RunSTAF to apply an appropriate 
correction to the PMT output. The temperature coefficient applied is the 685 nm value from data provided by 
Hamamatsu. 

18.5 Events log 

A range of operational events are logged within a text file stored at the following location… 

Documents → CT-RunSTAF → Events 

A new file is created each day. As an example, an events file created on 14th May 2021 will be 
named… 

210514 events.txt 

The events recorded are: 

AB reset 

ST reset 

Auto MLED failed 

DWM failed 

PEP failed 

The AB reset and ST reset events are triggered together after a successful system reset. A reset may 
be triggered by a high voltage spike through the mains supply. 

The Auto MLED failed, DWM failed, and PEP failed events can be triggered by low signal to noise. 
Increasing the Seq / Acq value under STAF setup will often help with this.   

In addition to the events listed above, a series of diagnostic codes are recorded within the events file 
if Log commands is active… 

Settings → Factory → Calibration and test modes → Log commands 

These codes are for factory use only. 
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19 RunSTAF installation and setup 

19.1 Updating an existing RunSTAF installation 

To access the most recent version of RunSTAF, use this link… 

https://1drv.ms/u/s!AkUtV8PHZSmVsMEO8Sk09MUnV1O4vg?e=iSldaA 

This provides access to the three folders shown here: 

 

The CDM21228_Setup folder contains a single file which is also named CDM21228_Setup. This is an 
application file that will install essential drivers. This file is not required when updating RunSTAF as 
the required drivers will already be installed. 

The RunSTAF documentation folder includes the most up-to-date version of this handbook plus 
other relevant documentation. 

The RunSTAF installation v7.3.1 folder includes two files named RunSTAF setup and setup. The first 
step is to compare the version number of this installation with the existing installation. To do this 
select Help → About RunSTAF from the RunSTAF menu bar. 

 

In this example, the About RunSTAF dialog shows that the current 
installation is v6.9.0. Consequently, the update (v7.3.1) should be 
downloaded and installed following the instructions below. 

19.2 Uninstall RunSTAF before installing the update 

 

Go to Add or remove programs within 
Windows System settings. Under Apps 
& features, find the RunSTAF tab and 
select Uninstall.  

Accept all the default options to 
complete the uninstall. 

 

https://1drv.ms/u/s!AkUtV8PHZSmVsMEO8Sk09MUnV1O4vg?e=iSldaA


Page 100 of 116 
 

19.3 Install the new version of RunSTAF 

Double click the RunSTAF setup Windows Installer Package.  

 

Accept all the default options to complete the installation. 

19.4 First RunSTAF installation 

When installing RunSTAF for the first time on a computer, drivers related to the LabSTAF hardware 
need to be installed and the computer needs to be connected to a LabSTAF unit.  

• Run the CDM21228_Setup application supplied with the download 

• Install RunSTAF  

• Connect the computer to the LabSTAF unit and power it up 

• Start RunSTAF 

Uninstalling RunSTAF in preparation for installation of an update (see above) does not uninstall the 
required drivers. 

19.5 Run LabSTAF on power up 

To run the LabSTAF system on power up, you will need to bypass the Windows 10 login and install 
RunSTAF as a start-up program (see below). 

You will also need to ensure that the Look for STAF system function is activated through Settings on 
the menu bar. 

19.5.1 Bypass the Windows 10 login 

You will need to be logged on as an administrator to set this up. 

• Go to Windows Start Menu and type Run 

• Hit Enter 

• In the Open field, type netplwiz  

• Hit Enter 

• Uncheck the box next to Users must enter a username and password to use this computer 

• Press the Apply button 

• Type the password for the account in the Password: and Confirm password: boxes 

• Press OK and OK again 

19.5.2 Run as a start-up program 

You will need to be logged on as an administrator to set this up. 

• Go to start menu and type Run 
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• Hit Enter 

• In the Open field, type shell:common startup  

• Hit Enter 

This should open File Explorer at the following location… 

C:\ProgramData\Microsoft\Windows\Start Menu\Programs\StartUp 

If the shell::common startup command isn’t available, you will need to type the above line into the 
File Explorer bar… 

  

If you already have a shortcut to RunSTAF on your desktop, copy it to the StartUp folder. If you don't 
have a shortcut on your desktop, open a second instance of File Explorer at the following location… 

C:\Program Files\Chelsea Technologies Ltd\RunSTAF 

Right click on the RunSTAF exe file and select Create shortcut from the popup menu. Move or copy 
the shortcut to the StartUp folder. 

19.6 Prevent the USB port going to sleep 

One power saving option with Windows 10 is to turn the screen off after a set period of inactivity. 
With some systems, this can lead to the USB port being powered down and data transfer from the 
attached LabSTAF unit being blocked. The safest option is to set the Screen to never turn off under 
Settings → Power & sleep. If this is not an option, the following steps will usually keep the USB port 
active. 

• Go to Settings → Devices → USB 

• Make sure the Stop devices when my screen is off… box is unchecked 

 

• Go to Windows Start Menu and type device manager 

• Hit enter to start the Device Manager application and go to Universal Serial Bus 
controllers… 

 

• For each device that include USB Root Hub in the description, double click to open the 
Properties and, under the Power Management tab, ensure that the Allow the computer to 
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turn off this device to save power option is unchecked 

 
 

19.7 Block the Serial Enumerator 

Ideally, the Serial Enumerator option for each of the COM ports provided by the LabSTAF unit should 
be blocked.  

• Go to Windows Start Menu and type device manager 

• Hit enter to start the Device Manager application… 

 

When LabSTAF is connected and powered up, you should find 
two instances of USB Serial Port (COM) under Ports (COM & LPT). 
In this example, the LabSTAF ports are COM7 and COM8. 

• Double click on COM7 to open its Properties window 

• Select the Port Settings tab and press the Advanced… button 

• Within Advanced Settings for COM7, under Miscellaneous Options, uncheck the Serial 
Enumerator box  

   

• Click the OK button to closed Advanced Settings for COM7 

• Click OK again to close the Properties window 

• Repeat for COM8 

• Restart the computer 

19.8 Block serial mouse detection on Startup 

In some situations, the data stream from LabSTAF can be interpreted as output from a serial mouse. 
The steps below can be used to prevent this. 
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• Go to Windows Start Menu and type regedit 

• Hit Enter to open the Registry Editor application 

• Navigate to: HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\sermouse 

• Double click on the Start tag and change the Value data field from 3 to 4 

• Hit the OK button 

• Exit Registry Editor and restart the computer 
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20 Glossary of terms 

This section provides a summary of the terms used within this handbook. A more extensive list of 
terms used within the relevant literature has been compiled by Schuback et al. (2021). 

20.1 Acronyms 

20.1.1 CCAP 

Culture Collection of Algae and Protozoa (https://www.sams.ac.uk/facilities/ccap/). Many of the 
examples provided within this handbook use cultures from CCAP. 

20.2 Term modifiers 

The base (unmodified) terms used within RunSTAF are valid for ST pulse measurements from a dark-
adapted sample. There are four modifiers used to define terms that don't fit with this description. 

20.2.1 The light-adapted state prime modifier (') 

Within the relevant scientific literature, the prime symbol is widely used to signify that a parameter 
is from a light-adapted sample. Within LabSTAF, a prime is always used when the integrated actinic 
light source is turned on. It should be noted that no minimum exposure time is defined for inclusion 
of the prime symbol. Consequently, the prime symbol should not be taken as indicating a steady-
state condition. 

Example: Fm in the dark becomes Fm' in the light 

20.2.2 The baseline corrected modifier (c) 

Baseline fluorescence (from any source other than photochemically active PSII complexes) 
contributes to the measured value of some fluorescence terms. Where a correction has been applied 
to subtract baseline fluorescence from the total signal, a lowercase c is added to the subscript of the 
fluorescence term.  

Example: Fm becomes Fmc after baseline fluorescence has been subtracted 

20.2.3 The second ST pulse modifier (s) 

The dual pulse method incorporated within LabSTAF generates a number of additional parameters. A 
non-subscripted lower case s is used to define a second ST pulse parameter. This is added to the left 
of the main term. 

Example: Fm for the first ST pulse becomes sFm for the second ST pulse 

20.2.4 The dimer modifier (d) 

RunSTAF incorporates two fitting algorithms for ST curves: the widely used Rho ST fit and the Dimer 
ST fit. For a relevant parameter, a lower case d is used to indicate it was generated from the Dimer 
ST fit. This modifier is added to the left of the main term. When combined with a second ST pulse 
modifier, the dimer modifier is closest to the term. 

Example: sPII for the Rho ST fit becomes sdPII for the Dimer ST fit 

  

https://www.sams.ac.uk/facilities/ccap/
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20.3 Basic STAF terms 

Term Meaning SI units (reported units, if different) 

xII Yield dimensionless 

kxII Rate constant s-1 

xII Time constant s 

xII Absorption cross-section m2 PSII-1 (nm2 PSII-1) 

axII Absorption coefficient m-1 

JxII Photon flux photons PSII-1 s-1 

JVxII Photon flux per unit volume photons m-3 s-1
 (µmol photons m-3 s-1) 

Table 20.1: STAF terms for PSII process 'x', where x is a placeholder for the terms in Table 19.2 (Boatman, 
Geider and Oxborough, 2019).  

Term Meaning 

LH Light harvesting 

P Photochemistry 

F Fluorescence 

D Thermal Dissipation or non-radiative Decay 

Table 20.2: Subscripts for use with STAF terms for each PSII process (Boatman, Geider and 
Oxborough, 2019). 

20.4 Additional STAF terms 

Term Meaning 
SI units 
(reported units) 

PII 
The initial rate at which photons are used to drive PSII 
photochemistry during a ST pulse 

photons PSII-1 s-1 

(photons PSII-1 µs-1) 

 Apparent connectivity among PSII complexes dimensionless 

EST 
Photon irradiance provided to the interrogated volume by 
the MLEDs during a ST pulse 

photons m-2 s-1 

(photons nm-2 [100 µs]-1) 

[QA] 
Proportion of photochemically active PSII complexes in 
the open state 

dimensionless 

Table 20.3: Additional STAF terms. The parameter  can also be defined as the probability of a photon 
absorbed at a closed PSII that was in the open state at t = 0 during a ST pulse being used to drive PSII 
photochemistry. Clearly, this requires that the photon is first transferred to an open PSII. 

20.5 Dimer-specific STAF terms 

Term Definition  

[oo] The proportion of PSII dimers in the oo state (both centres open) 

[oc] The proportion of PSII dimers in the oc state (one centre open, the other closed) 

[cc] The proportion of PSII dimers in the cc state (both centres closed) 

Table 20.4: Dimer-specific STAF terms 
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20.6 Basic fluorescence terms 

Term Definition  

Fo 

Extrapolation to t = 0 at the first ST pulse (origin of variable fluorescence) 

• All photochemically active RCIIs are in the open state 

• A pre-ST dark pulse of approximately 1 s is required for measurement of Fo' 

Fm At the asymptote of the first ST pulse (maximum fluorescence) 

Fv Fm – Fo (variable fluorescence) 

F Any point between Fo and Fm 

Fq Fm – F (fluorescence quenched by photochemistry) 

Fb Fluorescence signal not attributable to functional PSII centres 

Foc The baseline subtracted value of Fo such that Foc = Fo – Fb 

Fmc The baseline subtracted value of Fm such that Fmc = Fm – Fb 

Fc The baseline subtracted value of F such that Fc = F – Fb 

Table 20.5: Basic fluorescence terms. Only dark terms are shown. The light-equivalent terms all carry a prime. 
For example, Fm in the dark becomes Fm' in the light. 

20.7 Additional fluorescence terms for the second ST pulse 

Term Definition  

sF Extrapolation to t = 0 at the second ST pulse 

sFm At the asymptote of the second ST pulse  

sFq sFm – sF  

sFmc The baseline subtracted value of sFm such that sFmc = sFm – Fb 

sFc The baseline subtracted value of sF such that sFc = sF – Fb 

Table 20.6: Additional fluorescence terms required for the second ST pulse in a dual pulse sequence. Only dark 
terms are shown. The light-equivalent terms all carry a prime. For example, sFm in the dark becomes sFm' in 
the light. 

20.8 Derived fluorescence parameters 

Parameter Definition  

Fv/Fm Theoretically equivalent to PII when all PSII centres are in the open state and Fb = 0 

Fv/Fmc As above when non-zero Fb has been subtracted 

Fq/Fm Theoretically equivalent to PII when some centres are closed and Fb = 0 

Fq/Fmc As above when non-zero Fb has been subtracted 

Fq/Fv The so-called 'photochemical factor' (Baker and Oxborough, 2004) 

Fo/Fv Normalized Stern-Volmer equation when Fb = 0 

Foc/Fv As above when non-zero Fb has been subtracted 

Table 20.7: Derived fluorescence parameters. Only dark parameters are shown. The light-equivalent 
parameters all carry primes on each term. For example, Fq/Fm in the dark becomes Fq'/Fm' in the light. 
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21 Answers to FAQs and background material 

21.1 Deriving your own values of aLHII and/or PSII concentration  

As noted within RunSTAF terminology, the fluorescence values reported are on a defined STAF Unit 
scale. When incorporating fluorescence values within the derivation of aLHII or PSII concentration, 
the reported fluorescence values should be divided by 106 to bring them onto the same scale as Ka 

(default value of 11,800 m-1). Similarly, reported values for PII and LHII should be converted from 
nm2 PSII-1 to m2 PSII-1 to bring them onto the same scale as Ka. 

21.2 Units for measuring LED photon irradiance (EST) 

The reported units for EST are photons nm-2 (100 µs)-1. 
A value of 1.0 photons nm-2 (100 µs)-1 is equivalent to 16,603 µmol photons m-2 s-1. 

21.3 Dark FLC step Fv/Fm and Fv'/Fm' values 

When running a FLC, it is common practice to include a dark step after the highest Up step and 
before the Down steps. In the example shown below-left, a 120 s Dark step has been included after 
the 60 s 917 µmol photons m-2 s-1 Up Step 12 and before the 120 s 318 µmol photons m-2 s-1 Down 
Step 8 (as indicated by the red arrows). The data values for the 917 µmol photons m-2 s-1 Up step and 
Dark step are shown below-right. For the Dark step, the values are the dark equivalent of the light-
adapted terms shown. For example, the Dark value in the F' line is Fo and the Fm' value is Fm.  

  

In the case of Fq'/Fmc', the Dark value is Fv/Fmc. The values of Fo and Fm required to generate the 
Dark Fv/Fmc are from the ST data acquired during the Dark step. 

In the case of Fv'/Fmc', the Dark value is also defined as Fv'/Fmc'. The value of Foc' required for the 
Dark Fv'/Fmc' is generated using Equation 20.1 (Oxborough and Baker, 1997).  

 Foc′ = Foc (
Fv

Fmc
+

Foc

Fmc′
)⁄  Equation 20.1 

 
Within Equation 20.1, the only value measured from Dark Step 12 is Fmc'. All the remaining values 
on the right-hand side are from Up Step 1.  

By allowing for comparison between the Fv/Fmc measured directly in the dark and the calculated 
value, this process provides a check for the validity of Fv'/Fmc' and Fq'/Fv' parameters calculated 
from the same sample under illumination, which both require Foc' from Equation 20.1. 

21.4 The Stern-Volmer relationship, NPQ and NSV 

The Stern-Volmer relationship provides a theoretical basis for the decrease in Fm to Fm' that is 
commonly observed under actinic illumination: so-called non-photochemical quenching. The basic 
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concept of Stern-Volmer quenching within PSII is that quenching is induced by the accumulation of a 
class of molecules within the PSII light harvesting system with the capacity to accelerate the 
deactivation of excited light harvesting molecules. Under the Stern-Volmer relationship, this 
intermolecular quenching is in direct proportion to the concentration of quencher.  

It is important to note that Stern-Volmer quenching is not the only mechanism that can potentially 
change the value of Fm'. For example, so-called state-transitions can increase or decrease Fm' by 
modifying the physical cross section of the PSII light harvesting system. Within some setups, a simple 
change in biomass within the interrogated volume could also be responsible for an increase or 
decrease in Fm'. 

Non-photochemical quenching attributed to Stern-Volmer quenching is widely assumed to be at 
least partly regulated through the xanthophyll cycle in chlorophytes and brown algae and 
diadinoxanthin cycle in diatoms, dinoflagellates and haptophytes (See Goss and Latowski, 2020 for a 
recent review). Typically, the xanthophyll cycle is stimulated as incident light is increased beyond Ek. 
Within the chlorophytes and brown algae, violaxanthin is converted to zeaxanthin via the 
intermediate antheraxanthin. Within diatoms and dinoflagellates, diadinoxanthin is transformed into 
diatoxanthin (diatoms) or dinoxanthin (dinoflagellates). The conversion (de-epoxidation) of 
violaxanthin to zeaxanthin is reversed over tens of second to minutes in the dark. In contrast, de-
epoxidation of diadinoxanthin may not reverse in the dark. If, for example, diatoms are rapidly taken 
from high light to darkness, downregulation can remain locked in. A routine method for reversing 
this is to apply low light treatment for several minutes. An incident photon irradiance of 10 – 20 
µmol photons m-2 s-1 for 10 to 20 minutes at ambient temperature is a reasonable starting point for 
establishing the optimum pre-FLC treatment conditions (Schuback et al. 2021). 

Equation 22.2 provides a general equation for the Stern-Volmer relationship. 

 
𝐼𝑓

0

𝐼𝑓
= 1 + 𝑘𝑞𝜏0 ∙ [Q] Equation 20.2 

Where 𝐼𝑓
0 is the fluorescence intensity in the absence of the quencher, 𝐼𝑓 is the fluorescence 

intensity in the presence of the quencher, 𝑘𝑞 is the quencher rate constant and 𝜏0 is the lifetime of 

the excited state of the fluorescent molecule in the absence of quencher. For PSII fluorescence, we 
can substitute the terms on the left-hand side of Equation 20.2 to form Equation 20.3.  

 
Fm

Fm′
= 1 + 𝑘𝑞𝜏0 ∙ [Q] Equation 20.3 

Although routine measurement of 𝑘𝑞 and 𝜏0 is not practical, we can simplify Equation 20.3 to 

provide Equation 20.4.  

 [Q] ∝
Fm

Fm′
− 1 Equation 20.4 

To generate a value for NPQ, we simply replace the proportionality sign with an equal sign. 

 NPQ =
Fm

Fm′
− 1 Equation 20.5 

From Equations 20.3, 20.4 and 20.5 it should be clear that values for NPQ can only be compared if 𝑘𝑞 

and 𝜏0 are constant and [Q] is zero at Fm. A significant problem with Equation 20.5 is that the 

calculated value of NPQ is sensitive to baseline fluorescence as well as [Q]. It follows that that NPQ 
values cannot reliably be compared between samples with different values of Fv/Fm. 

NSV was used as an alternative to NPQ within McKew et al. (2013) to allow for comparison of 
downregulation between high light-grown and low light-grown cells of Emiliania huxleyi (clone CCMP 
1516). Within this study, it was assumed that differences in Fv/Fm between high and low light-grown 
cells were due to differences in pigment composition, rather than differences in baseline 
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fluorescence. This assumption was supported through HPLC analysis of pigments. Values for NSV can 
be generated using Equation 20.5. 

 NSV =
Fo′

Fv′
 Equation 20.5 

While both NPQ and NSV can be used to track changes in downregulation with increasing incident 
photon irradiance within a single sample, NSV also allows for comparison between samples with 
different values of Fv/Fm. In the study of McKew et al. (2013) there were no significant differences in 
NPQ values for the high light-grown and low light-grown cells between zero and 300 µmol photons 
m-2 s-1. In contrast, the high light-grown cells had higher values of NSV at all points between zero and 
1200 µmol photons m-2 s-1. 

 

Figure 20.1: Comparison of NPQ and NSV data for 
High Light (HL) and Low Light (LL) grown cells of 
Emiliania huxleyi (clone CCMP 1516). The Fv/Fm 
values were 0.4 for the HL-grown cells and 0.5 for 
the LL-grown cells. 

These data are from parts d and e of Figure 2 within 
McKew et al. (2013). 

21.5 Alternative terminology 

As noted in Section 2, a structured approach has been taken to the terminology used within this 
document. As far as possible, terms are derived from core elements that have been in use for several 
decades. The aim has been to employ terminology that is both self-consistent and unambiguous. 
Inevitably, this has led to alternatives to some established terms being generated. This section 
compares the terminology used within this document with terminology used more widely. 

21.5.1 Absorption cross sections 

The most widely used equations for fitting ST curves to generate a value for the absorption cross 
section of PSII photochemistry were originally published by Kolber, Prášil and Falkowski (1998). Table 
20.1 provides a comparison of the terminology used within this original publication and the 
terminology used here. 
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KPF term 
(reported 
units) 

RunSTAF term 
(reported 
units) 

KPF description RunSTAF description 

PS II (Å2 photon-1) PII (nm2 PSII-1) 
Functional absorption cross 
section 

Absorption cross section of PSII 
photochemistry 

aPS II (Å2 photon-1) LHII (nm2 PSII-1) 
Optical absorption cross 
section 

Absorption cross section of PSII 
light harvesting 

p  (dimensionless)   (dimensionless) Extent of energy transfer  
Apparent connectivity among PSII 
complexes 

Table 20.8: KPF references Kolber, Prášil and Falkowski (1998). 

Units of nm2 are used in preference to Å2 because the Angstrom is not part of the SI system. Within 
the relevant scientific literature, the Greek letter Rho is now more widely used than an italicised p to 
define connectivity or energy transfer. Although 'functional absorption cross section' and 'effective 
absorption cross section'  are widely used within the literature, they are inconsistent with the overall 

terminology used within this document. The units for PII within the literature are now more likely to 
be reported as unit area per PSII rather than unit area per photon. 
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22 Troubleshooting guide 

22.1 Clearing all Windows COM ports 

If the LabSTAF or AutoSTAF plus DCU combination is not running correctly, even after one or more 
power cycles of the system, it is worth clearing all COM ports through Device Manager. 

In the example shown below, the USB Serial Ports (COM9 and COM10) under Ports (COM & LPT) are 
provided by a LabSTAF unit that is plugged into the computer and powered up. 

 

Select View → Show hidden devices from the menu.  

 

The Ports (COM & LPT) list now includes additional ports that are allocated by Windows to devices 
that are currently not connected. Right click over each USB Serial Port (COM..) and select Uninstall 
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device. Include the two ports (COM9 and COM10) in this process. Do not select the option to Delete 
the driver software for this device when uninstalling. 

Once all USB Serial Ports have been deleted, reboot the computer. When the LabSTAF or AutoSTAF 
plus DCU are connected and powered on, new USB Serial Ports should be created under Ports (COM 
& LPT) in Device Manager. In this example, the two USB Serial Ports provided by a connected 
LabSTAF unit have been reassigned as COM3 and COM4. 
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